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Introduction

This project is focused on creating an improved trail system management plan with an approach to
sustainability management for Hood River County, Oregon. The emphasis of this project is to
implement a trail management database design, physical map design, and web map design that
support ideas of sustainability management. This project provides an implementation plan to be
considered by Hood River County Forestry Department for improving sustainable recreation
management on their land.

Background

Hood River County Forestry Department (HRCFD) manages 31,064 acres of forest land in Hood
River County. The land is primarily managed for commercial timber production. Over time, a large
network of unmanaged trails developed in the Hood River County (HRC) forest lands, and
eventually the County adopted a more managed approach to recreational trails. In 2003 the Hood
River County Board of Commissioners (HRCBOC) passed an ordinance requiring HRCFD to
manage the system of recreation trails. It also called for the creation of a Forest Recreation Trail
Committee (FRTC) that would be composed of members of the public representing a diverse
spectrum of stakeholders. The ordinance also required the HRCFD to develop a Recreation Trail
System Master Plan (RTSMP) which initiated a long process of planning and working toward that
goal. The development of the RTSMP incorporated a wide range of stakeholder groups, funding
sources, and assistance from outside organizations (Figure 1). After many years of work, the
RTSMP was finalized and adopted by Hood River County in December 2010. Throughout this
process the HRCFD has recognized the many direct and indirect social, economic, and health
related benefits that come from having recreational trails as a public resource, but the department
has limited financial resources to commit to recreation management since there is little direct return
of revenue to the department from these activities. HRCFD has been fortunate to acquire several
recreation-focused grants for on-the-ground projects, but these typically have fallen short of
providing funding for staff time to improve the trail system GIS data and map products. Several
years ago HRCFD obtained grant funds for commercial printing of a trail map. At that time HRCFD
staff used GPS equipment to collect all trail locations and then they created the first trail system
map for public distribution. The original map has served the public and the HRCFD well for several
years; however, at the initiation of this project the trail system map is significantly outdated and
inaccurate. The HRCFD has requested that it be completely redesigned and improved by someone
with expertise in GIS and cartography. Nyerges and Jankowski define a complete GIS as “a
combination of hardware, software, data, people, procedures, and institutional arrangements for
collecting, storing, manipulating, analyzing, and displaying information about spatially distributed
phenomena for the purpose of inventory, decision making, and/or problem solving within
operations, management, and strategic contexts as related to issues at hand” (Nyerges & Jankowski,
2010). HRCFD does not need a completely redesigned GIS, but they do request assistance in
developing some workflow enhancements to their current GIS. In the process of developing a



redesigned map, HRCFD has also requested assistance with data design improvements that will
help them better manage their trail system datasets going forward. The HRCFD has stated that they
lack the technical skills necessary for a professional redesigned map and manipulation of the
associated data.

The HRCFD has stressed the importance of developing a high quality and current trail system map
for trail and land management. The map is the document that links the HRCFD as a management
agency to the physical trail system on the ground, and it also links them with the public. It is
therefore an extremely important part of their recreation management. Also, the Forest Recreation
Trails Committee, which meets monthly, is responsible for making decisions and recommendations
for trail management. But in order for them to make good decisions, they need current and accurate
maps and data. The types of recreation that are very popular in the trail network include hiking,
running, mountain biking, horseback riding, motorcycle and All Terrain Vehicle (ATV) riding. The
trail map is the primary means for HRCFD to define the trail designations for the various use types.
Since the public makes extensive use of the recreation map for making good decisions, they can
clearly benefit from a better designed and more informative map. And finally, the availability of an
accurate trail map is critically important to emergency responders when dispatching to incidents in
the forest.
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The creation of the RTSMP and the efforts during the three years since it’s development have set
HRC on a path towards a sustainable system of recreation trails that are used year-round by
residents and visitors. Sustainability was built into the RTSMP, which is likely the single most
important aspect of the HRCFD efforts. Based on research, “The goal of sustainable environment
planning, policies, and governance is to design processes that return our planet to a more balanced
level of use” (Wade, 2013). Maintaining a high level of sustainability, despite heavy tourism to the
HRC area, requires a delicate balance of management, enjoyment and ongoing efforts as described
in the RTSMP. In 2003, the HRC Forest ‘trail” system consisted of over 160 miles of unauthorized,
dangerous, environmentally damaging and unsustainable trails spread over 31,064 acres of HRC
forest land and private property. Geographic information system technology is an essential tool for
designing and implementing sustainable processes at any scale (Wade, 2013).

According to recent research, “Sustainability is commonly misunderstood as being equal to self-
sufficiency, but in a globalized world virtually nothing at a local scale is self-sufficient. To become
meaningful, urban sustainability therefore has to address appropriate scales, which always would be
larger than an individual city” (EImqvist, 2013). At this relatively small scale (31K acres), the Hood
River County forests may be self-sufficient in terms of maintaining forest land, plants and animals.
However, it is not self-sufficient, as a recreational site, especially with thousands of visitors per year
hiking, biking, riding horseback, motorcycles, quads and 4x4’s within. There must be a balance of
recreation and recreation management to facilitate the continued processes of timber harvesting and
user enjoyment.

Based on research by Elmgvist, “Complex systems are, according to resilience thinking, rarely
static and linear, instead they are often in constant flux, highly unpredictable and self-organizing,
with feedbacks across time and space” (EImqvist, 2013). The resilience of the HRC forest is in
constant flux, highly unpredictable and somewhat self-organizing, however, without organization, it
will become temporally less resilient.

Elmqvist points out that the local city scale is too narrow for true resilience and sustainability
thinking (EImqvist, 2013). Perhaps the scale of the Hood River project is ‘too narrow’ to understand
forestry resilience and sustainability while a much larger scale would provide more insight. A
narrow focus on a single city is often counterproductive and may even be destructive since building
resilience in one city often may erode it somewhere else with multiple negative effects across the
globe (Elmqvist, 2013). With that being said, it would be illogical to NOT carry through with this
GIS Improvement project because the scale may be too narrow. It may however, given the
aforementioned research, be difficult in the end to declare that the HRC timber forest and
recreational trails are sustainable and resilient.

As manager of the trail system (in coordination with multiple user groups, agencies, and business
leaders), the project sponsor has very limited face to face contact with the thousands of users on the
trail system. They stated that the only true connection they have with the users is through the ‘data’



that they ‘share’ via a map. It is through this data sharing that the sponsor indirectly drives the local
recreation economy, establishes rules and regulations, and makes improvements to
maintain/enhance the safety of the trail system while maintaining a sustainable logging operation in
the HRC forest.

Based on research, trail design and trail management are very important when it comes to
sustainability management. According to researchers, “a trail system that facilitates access to
remote ecotourism destinations, provides safe, high quality recreational experiences, and
concentrates traffic on durable treads maintained to minimize resource degradation can only result
from professional planning and management” (Marion & Leung, 2004).Other researchers have
discussed the use of developing a well-designed database composed of field data as well as
examining the use of regression tree analysis . Also, researchers have utilized GIS to create a least-
cost path for an optimized trail route (Tomczyk, & Ewertowski, 2013). With that being said, we are
continuing to work towards providing Hood River County with improved data as well as a trail
management system that will help the County sustain and maintain the future use of trails. While
this is a project for GEOG 569, technically our processes should be termed a program because this
is starting out as a project; however the goal is to enhance the sustainability management of the
HRC Recreational Trail system (Somers, 2010). While our time is limited for new additional
analysis, we decided we could work towards future sustainable trail management analysis ideas for
our project sponsors to consider for the future.

Problem Statement

Based on the HRCBOC ordinance, the HRCFD has been required to manage and maintain the
recreational trail system. The ordinance has also required the development of a Forest Recreation
Trail Committee and a Recreation Trail System Master Plan. With several years of hard work, the
Recreation Trail System Master Plan was created in December 2010. While the plan was created,
there is still much work that needs to be done to create a system for maintaining the recreational
trails. The HRCFD has had to deal with little financial and GIS resources for managing and
updating recreational trails. Due to limited resources, the County has been faced with outdated
recreation trail data and paper maps. The HRCFD would like to update and redesign their trail maps
as well as find a database management design that will help them better manage and maintain
recreational trails for the future.

Project Goals

The first goal of this project will be to design an improved trail system management plan. The goal
will be to create a trail database that will help the HRCFD organize and standardize their data while
making updates in the future.



A second goal of this project will be to provide an updated Hood River County non-motorized trail
map ready for commercial printing. The updated trail map will be printed and made available to the
public. This printed map will be very useful for trail users as well as County employees in charge of
managing the trails.

A third goal of the project will be to offer suggestions for further study and analysis as the County
works towards maintaining a sustainable trail management system. The goal will be to provide
sustainable examples of maintaining recreational trails based on current research. Also, the goal will
be to provide some new GIS ideas based on growing trends such as online web maps.

Lastly, a fourth goal of the project will be to complete a financial analysis based on the research
(Lerner & Technology Association, 2007). The goal of the financial analysis will be to help the
County determine if it is financially feasible to incorporate our sustainable trail management system
recommendations into their workflow.

Tomlinson notes that in order to “develop an effective GIS, the GIS planner must have a clear
understanding of what the agency or company does, it’s working plan to do it and how GIS can help
accomplish the mission” (Tomlinson, 2011). The overall goal/mission of the Recreation Trail
System Master Plan is to, “provide a sustainable system of recreation trails within the HRC forest
lands that is managed cooperatively by the HRC Forestry Department, all recreation user groups,
and trail partners, for the benefit and enjoyment of HRC residents and visitors” (Hood River
County, 2010). Preparing a well-designed trail system will assist in keeping visitors from trampling
into sensitive off-trail areas as well as providing a highly effective resource protection strategy
(Cahill, Marion, & Lawson, 2008). These strategies, combined with a highly detailed and accurate
map will preserve the fragile landscape, thus increasing the resilience of the landscape. Such
techniques and practices constitute a core component of sustainable tourism and trail management.
(Marion & Leung, 2004; Newsome, 2002). Trail impacts such as muddiness, which causes
widening and erosion can be effectively addressed by relocating a trail to a side-hill alignment with
design features to avoid these common problems (G. A. O. United States, 2004). Hood River
County practices are focused on sustainable remedies to maintain trail system resilience without
mandating restricted use and access. HRC provides a continually updated and managed recreation
area to locals and visitors from around the world. Visitors utilize signage and maps to self-manage
their activities throughout the county trail system. By providing visitors with up-to-date trail
information alongside sustainability ‘best practices’ in the form of ancillary text (on the ‘back’ of
the map), the map facilitates further protection of the natural landscape.

Obijectives

To achieve our project goals, we developed a dynamic project workflow process/diagram that will
address, manage and guide the development of additional steps that are necessary to accomplish our
goals within the eight week timeline (Figure 2).



Workflow Diagram: Hood River County Forestry Department GIS Improvement Project
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Figure 2: Workflow diagram.

In regards to our first goal, we thoroughly analyzed the trail data to determine a method that will
allow a more streamlined approach to data maintenance. We developed a proposed trail database
design that will enhance the Forestry Department’s data management efficiency.

To accomplish our second goal, we compiled all of the necessary data and reference information for
creating the non-motorized trail map. Then each of us will be responsible for creating, updating, and
symbolizing a set of layers. By week five our plan is to be done with any data editing. Between
weeks five and six we plan to compile the data layers into a draft map to present to our project

Sponsors.

In order to reach our third goal, our plan will be to do extensive research on sustainable trail
management as well as GIS technology ideas to provide as future recommendations. By week seven
we plan to compile our research ideas and come up with an example to present to our project

Sponsors.



To achieve our fourth goal, we plan to compose a financial analysis by using the business case
template that was suggested based on research. During weeks six and seven, we developed a
complete financial analysis of our proposed solutions.

Scope

Much of the ‘Scope’ for this project was clearly defined in the ‘project questionnaire’ provided to
us from HRC and Professors Aguirre and Withers. Upon meeting with our project sponsors, we
confirmed that the scope of our project is to provide an updated non-motorized trail map that can be
printed and created into a water resistant hard copy map.

Information products

The hard copy map will be very useful for trail users, County staff, and maintenance workers. This
project will also improve the County’s trail system data management, design, processes, and
workflows (a GIS program). The development and implementation of the improvements will allow
Hood River County to better maintain their trail data and provide them with the ability to
consistently produce up-to-date maps. All of these components will lead to improved sustainability
management going forward.

People

e Henry Buckalew: Main organizer of the project

e Ellen Davis: Provided some data and will mostly be in charge of maintaining the data in the
future

e Mike Schrankel (County GIS Coordinator): Provided some data and in charge of the GIS
program for Hood River County

e Field crew (for GPS work): In charge of checking and maintaining trails

Hardware

Hardware considerations for this project were predicated upon what was already in use. HRCFD has
two computers functioning adequately, as do all team members. HRCFD also has Trimble GPS
units with which they gather data from the field. No additional hardware purchases are necessary.
For the purpose of documenting what was used during analysis and cartography, the hardware
specifics are listed below.
e Rick Hollatz: HP Pavillion Desktop PC running 64-bit Windows 7 Home Premium, Service
Pack 1. Intel(R) Core (TM) i7 CPU @ 2.67 GHz, 8 GB RAM.



e Gregory Lund: Puget Systems custom laptop running 64-bit Windows 7 Professional service
pack 1. Intel Core i7-3820QM CPU @ 2.7 GHZ, 32 GB RAM, two internal solid state hard
drives (c: 250 GB & d: 250 GB).

e Alyssa Tanahara: MacBook Pro laptop running 32-bit Windows 7 Home Premium, Service
Pack 1. Partitioned hard drive. Intel(R) Core(TM) i7-2620M CPU @ 2.70 GHz, 4 GB RAM.

Due to the absence of accessible server space, each team member stored a local copy of the data on
their personal Hard Drives. All three team members utilized the c: drive for data storage. While
editing a specific geodatabase, all other team-members refrained from editing until it was finalized
by the member that was editing, uploaded and then re-downloaded (in its entirety). One important
measure our group used in the data-management process was to keep all data in separate small
geodatabases to facilitate easy manipulation and transfer amongst the team and eventually back to
HRC and Mr. Buckalew. Google docs, Google Drive, Dropbox, and email data exchanges (for small
files) have been leveraged along with a sophisticated real time online data-use log to prevent
multiple renditions of the data.

Software

ArcGIS 10.0 SP3 was used to maintain the data throughout the project in an effort to replicate the
sponsor’s system as closely as possible. HRC maintains two ArcView licenses. Creating annotation
layers will ensure accurate placement and consistency of the label location. For the purposes of
creating a ‘Map Service’ on the UW Geography Server, one team member upgraded to ArcGIS
10.1. The map service on the UW Geography Server will be used to create a web map on
ArcGIS.com. ArcGIS 10.1 is required to create a map service, because the UW Geography Server
runs on ArcGIS Server 10.1. In order to publish a map service on a server they need to be in the
same version. For example, a map document (.mxd) in ArcGIS 10.0 cannot be published into a map
service on an ArcGIS 10.1 server. However, there are workarounds for publishing a 10.1 map on a
10.0 server.

Several types of online software allowed our group to work collaboratively on project components
in real-time. Google documents were used for collaborative word processing and spreadsheet
development. Also, each team member registered for a Microsoft SkyDrive account to access the
collaborative capabilities of Visio in ‘the cloud' to create workflow diagrams. This made it possible
for us to all work on one Visio document without having to worry about redundancy or data
overwrite problems that would likely occur if individual versions of the documents were being
edited and then shared or compiled. Skype was used on many occasions for conference calls with
all team members attending.



Data Acquisition

Much of the specific data necessary for this project was provided by the sponsor and the HRC GIS
Department. Other data came from the USGS, Oregon State, USFS Mt. Hood, Skamania County-
WA, and others as detailed in Appendix A - Data Sources Spreadsheet. The
DataSources_Spreadsheet document on Google Drive was utilized to prevent data conflicts.
Because Google Drive works in nearly ‘real time,” it was possible for all three team members to
view specifics about the data, and to know when it was being edited by another team member. The
three left hand columns were used extensively to prevent two (or three) team members from editing
the same geodatabase at the same time. When one team member was editing data in a geodatabase,
that person (editor) highlighted the columns in the Google Drive document so that the other team
members knew that it was in ‘editing” mode, and therefore to not edit that data until it was uploaded
back to Dropbox by the editor. The other users would wait and then subsequently replace their hard
drive copy (in their c: drive) with the new (edited) version provided by the editor when they were
done. This process worked, we had zero instances of data conflicts. To facilitate future management
of the data, we will be providing workflow guides to help guide the Forestry Department in the
efficient and effective management of their data moving forward. This process will require two sets
of some data, one for ongoing data management (dynamic) and another for cartographic purposes
(static).

To facilitate easy data transfer and sharing between sponsor and team partners, each set or group of
data is housed in a separate geodatabase. Many smaller geodatabases will be easier to manage and
transfer between machines than fewer large geodatabases. All of the data is stored in a single folder
named ‘HRC Trailmap’ as shown in the graphic below (Figure 3)

=l £ CAHRC_TrailMap ----...___________}
= £ Data Master Project Fc:ldeD
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5 E3 lidar Master Data Folder >
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Figure 3: Data Storage Basics
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Design Considerations for Sustainability

Sustainability management, ecosystem services, and resilience thinking are components at the core
of this project. HRCFD is tasked with serving the public as a land and resource management
agency and it is in the best interest of the organization to carry out practices that are
environmentally conscious, scientifically sound, socially acceptable, and economically viable. This
project, with the support of HRCFD, seeks to design and implement strategies and tangible
materials that create a more desirable future condition for the land being managed and the people
being served.

Geographic Scale

The focal scale of this project is the ‘Northwest Area’ of Hood River County’s forest lands (Figure
4. Out of all the land areas managed by HRCFD, this area receives the majority of all recreation
impacts due to its close proximity to the population centers of the county, and because it is easily
accessed by visitors travelling from outside the area. While the three other ‘areas’ under HRCFD’s
management are not the primary focus of this project, the considerations developed herein can
likely be expanded to these additional areas at a later time. At a regional scale, outside of the areas
owned and managed by HRCFD, the landscape has a mix of public and private land that range in
type of use and intensity of use. For example, there are areas of dense residential uses, agriculture,
timber production, designated wilderness. While interaction between the activities that occur on
HRCFD land and other lands in the regional vicinity certainly exist, the focal scale of this project is
fairly rigid and has defined boundaries in terms of mapping and data design.

11
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Figure 4: A map of the four distinct areas managed by HRCFD. Map was obtained from the RTMP
document (Hood River County, 2010).

Temporal scale

When considering designs that will improve sustainability management, temporal scales have
several implications for this project. Consideration should be given to the fact that elements of the
project must fit HRCFD’s management activities and needs. As such, we considered that
management activities may be variable over time. For example, managers of trail systems should
not overlook the seasonal influences of weather on trail conditions. Management activities and
specific decisions are likely to vary with seasons. Management (and data designers) should also
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consider the influences of things like the time of day, the day of the week, and the season of the
year for how these influence the number of recreational users and the spatial distribution of where
those users choose to recreate. To the extent that it is possible, temporal processes should be built
into the GIS data during database design in order to establish a means for improved temporal
analysis.

Organizational Scale

This project is designed to improve HRCFD’s ability to accomplish its mission as a land
management agency. It will provide efficiencies for staff within the department. On a larger
organizational scale, this project may have additional influences. For example, the GIS Department
at HRC, as the division responsible for storing GIS data, may see additional benefits from improved
data structure and organization. Trail datasets are currently stored redundantly and with poor
consistency of content. Our newly designed data structure, as well as procedures for managing and
maintaining that structure, will be a benefit to all data managers and users throughout the
organization. Better data will also provide more accurate and current information that can be used
by several other departments at HRC.

Alternative Designs

Two important design considerations for this project were establishing the geographic extent, and
deciding the primary user for which the maps were meant to benefit. In many ways these two
considerations were intertwined. During scoping exercises HRCFD had stated they need updated
maps (and data) specifically designed for two user types. These included motorized users and non-
motorized users. As an organization HRCFD has distinct reasons for separating these uses. For
one, they have a need to provide different information to each user type. They typically produce a
separate map for each user because this allows them to tailor the information specific to the use
type. Also, they are able to obtain funding to develop materials for motorized trail management, but
far less likely to obtain similar funds for non-motorized management. This stems from the
availability of grants that are tied to Oregon State gasoline tax dollars. These grants must be
utilized in projects promoting or enhancing motorized uses.

Given these considerations, and through consultation with HRCFD as the project sponsor, it was
decided that we should focus our project primarily toward non-motorized uses. Because non-
motorized users are also allowed to use motorized trail areas, the project geographic extent was
established such that it covers both. Additional detail in the maps is focused on areas that are most
heavily utilized by non-motorized users.
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Design

As with most significant GIS projects, the overall design has been dynamic throughout the process,
as we worked towards meeting the Sponsor’s required deliverables and GEOG 569 Course
Requirements. The Workflow Diagram (Figure 2) details the steps and processes that were
completed throughout the eight weeks of the course.

Data Design

A large variety of datasets were used in the development of our map products. In some cases
datasets were obtained in a form that was well suited to immediate use, however many other
datasets required an extensive amount of editing in order to prepare them for use in our project.
Data was managed in many individual file geodatabases with each geodatabase representing a
particular data theme (e.g. streams, roads, wilderness, etc.). In many cases we were able to import
data from various sources into our geodatabases, manipulate it, and derive additional data projects
from it. However, in many cases data needed to be developed entirely by us by reviewing other
reference materials, or in some cases, via field reconnaissance. The culmination of our data
collection, manipulation, and development efforts was the compilation of a vast amount of data
(Figure 5) requiring approximately 20 gigabytes of file storage.
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25 Geodatabases

29 Raster datasets

76 Geometry feature classes

19 Annotation feature classes

20 Layer files {for symbology)
3 Tables

3 USGS_Topo.gdt
4 B HoodfwerCounty Mesas

Figure 5: Datasets utilized in the project (screenshots from ArcCatalog)

The large majority of all data we collected and manipulated was solely intended for cartographic
representation in our map(s). As part of the cartographic representation we made extensive use of
geodatabase annotation to provide the necessary labeling of features in the map(s). Both feature
linked and standard annotation were used.

In addition to the data needed for cartographic representation, we also developed an extensive
geodatabase design to store trail system data because it will be actively managed by HRCFD at the
conclusion of our project. A design was established that will improve HRCFD’s ability to manage
and maintain the data while reducing attribute redundancy, providing superior quality control
measures, and ultimately being more efficient and effective in carrying out their mission. The trail
system geodatabase makes use of subtypes, coded value domains, and feature linked annotation
(Figure 6). It was also developed with a wide range of improved attributes fields that will be useful
for improving both operational and sustainable management. The general use and purpose of each
field in the NW_Area_Trails feature class is provided in Table 1. This feature class is the most
important data layer in the geodatabase because it includes most of the primary trail attribute
information.
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Figure 6: Image of the Trails geodatabase schema (from ArcGIS Diagrammer) showing all feature

classes, subtypes, and domain lists.
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Description of the 'NW_Area_Trails' Feature Class Attribute Fields

Field

Field Name* Basic Description Field Type Length Domain Purpose and Use Considerations

The common name for a particular trail (e.g. 'Seven Streams Loop'). This field is
Name Trail name Text/String 40 used in a feature linked annotation class.

This field can be used for suffix characters that adjoin to the trail name but are
NameExt Trail name extension Text/String 20 best managed in a separate field.

This field is used for the trail number for administative and map navigation
TrailNum Trail number Text/String 20 purposes. This field is used in a feature linked annotation class.

The trail designation is the subtype field defining the intended use type for the

trail. Subtypes include 'Motorized', 'NonMotorized', and 'Unknown'. Subtype
Designation Trail designation Short integer values define default values and behaviors for other fields.

The trail status is used to define current status. Values are derived from a domain
Status Trail status Text/String 30 TrailStatus (e.g. Active, Closed, Proposed, Under construction, decommissioned, etc.)

The trail status comment field is for free form text. It provides a place to enter
additional information about the value used in the status field, for example,
Status_Cmt Trail status comment Text/String 70 providing additional detail for why a particular trail has a status of 'Closed'.

This field is used to define the ownership of the land where the trail is located. In
situations where a trail crosses multiple ownerships, the trail should be broken
Ownership Ownership Text/String 20 Ownership into individual segments for each ownership.

This field defines the trail difficulty level with one of four levels (i.e. Beginner,
Difficulty Trail difficulty level Text/String 20 DifficultyLevel Intermediate, Advanced, Expert).

This field defines directionality for trails as to whether it is meant to be a one-way
Direction Trail directionality Text/String 10 Directionality or two-way trail.

Trail use types (from domain) are defined in a heirarchy in the following order:

4x4, ATV, Motorcycle, Bicycle, Equestian, and Hiker. The hierarchy establishes the

maximum allowed use for any particular trail. A trail is open to its maximum

allowed use as well as any lower level uses. For example, a trail designated as

'ATV'is also open to motorcycles, bicycles, equestrians, and hikers. A trail

designated as 'Motorcycle'is open to lower level uses, but is NOT open to 'ATV' or
User_Max Maximum allowed trail use Text/String 20 UserType '4x4' uses.

This field is used to define the primary trail user type (where applicable). For

example, certain trails are specifically designed to be bicycle trails. The value

used in this field does not necessarily indicate that other uses are not allowed,
User_Primary Primary trail use Text/String 20 UserType however, other uses are less favorable and perhaps not recommended.

This field is used to categorize trails based on the bicycle experience provided.

Trails are defined as either cross-county (XC) or freeride (FR). Cross-county trails

generally provide variations in grade on an mostly obstacle free, smooth surface

trail. Freeride trails generally provide more advanced terrain and man-made

technical features (stunts). Freeride trails are often designed to be ridden in one

primary direction (downhill). This field is used in combination with the Name
BikeStyle Trail type (Bicycle style) Text/String 10 BicycleStyle field in developing the feature linked annotation class for name labels.

This field is used to define the date that a particular trail is
Date_Est Date of trail establishment Date established/constructed.

This field is used to define the date that a particular trail is decommissioned (if
Date_Decom Date of trail decommissioning Date applicable).

This field is used to enter free form text describing the details of the two previous
date fields. The field holds enough characters that a running log of events can
Date_Cmt Date comment Text/String 100 also be maintained for a particular trail segment.

This field serves as a free form text field where trail closure information can be

logged. For example, certain trails may be closed to certain uses during the wet

season or fire season. This field allows for a description of closure details as
ClosureCmt Trail closure comment Text/String 100 applicable.

This is a free form text field that allows the data manager to log any information

that is related to the sustainablity of the trail. For example, if sustainability issues

are identified such as resource damage or areas needing trail work, they should
Sustnblty Trail sustainability comment Text/String 50 be described here so they can be addressed.

*Note: The benefit of using short field names in the attribute table is that it keeps the length of overall data paths as short as possible. Also, when converting from geodatabase feature
classes to shapefiles, it is beneficial to maintain field names that are 10 characters or less because of the limitation of shapefiles. Fields longer than 10 characters are otherwise
truncated when converted to shapefile which can generate data management challenges.

Table 1: A Description of attributes in the trails feature class.
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Data Methods

Many advanced data management and data manipulation techniques were used to create specific
cartographic representations/effects. Some of these are summarized below and in several cases are
supplemented with additional appendix documentation:

Water body vignettes: The purpose of a water body vignette is to subtly symbolize a difference
between shallow and deep water for a better cartographic representation. In order to achieve this, a
feature class representing large water bodies is converted to a raster with cell values assigned
differently based on their distance from shore. Areas closest to shore are assumed to be shallower
whereas areas further from shore are deeper. The resulting raster is symbolized with a lighter blue
color representing shallow water and a darker blue color representing deeper water (Figure 7).
Additional details on how this procedure was performed are provided in Appendix B.
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Vegetation simulation from LiDAR: The purpose of simulating vegetation using LIDAR is to
enhance the map reader’s orientation and understanding of features that are represented on the
ground. In order to apply this cartographic technique, a Bare Earth LiDAR digital elevation model
is subtracted from the Highest Hit (also known as Full Feature) LiDAR digital elevation model
using the Raster Calculator. The resulting (output) raster has cell values representing only the
height of vegetation (or other structures like buildings) that are above the ground surface. Next, this
raster can be symbolized to represent the difference in height of vegetation (e.g. no color where
there is no vegetation, lighter green for shorter vegetation, and darker green for taller vegetation).
This raster can be overlaid on a hillshade image derived from Highest Hit LIDAR in order to
cartographically represent vegetation height (Figure 8). Additional hillshade rasters, along with
various levels of transparency, can also be used to provide cartographic representation of
topography to supplement the visual effect.
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Figure 8. Vegetation height is simulated through symbology with LiDAR data. Darker green is
taller vegetation and lighter green is shorter vegetation.

Bump map techniques: Bump mapping techniques can be used to simulate vegetation through the
creation of artificial ‘Bumps’ in a digital elevation model (and the subsequently derived hillshade
image) that represent individual features (e.g. trees, bushes, etc.). The incorporation of bump
mapping techniques in this project stemmed from a need to manipulate the appearance of vegetation
in locations where our LiDAR-generated vegetation symbology was inaccurate. The problem we
identified was that we are mapping an actively managed forest where timber harvests have occurred
since LiDAR flights were completed (2008). In other words, our symbology derived from LIiDAR
was showing forest in areas that had been recently clear-cut or thinned. In order to generate a more
accurate map we used bump mapping in these areas to simulate the different silvicultural
treatments. Clearcut-areas were essentially manipulated to appear as mostly devoid of trees but
having sparsely dispersed ‘leave trees’ which are required under Forest Practice laws. Thinned
areas were manipulated accordingly so that they appear as randomly dispersed trees rather than a
dense forest. Bump mapping tools were downloaded from the ESRI Mapping Center Models and
Scripts website. The tools run using customizable Python code, which allow for the creation of
different tree shapes (e.g. cones and domes) and sizes (Figures 9 a-c), as well as the creation of the
desired characteristics for density of tree spacing (Figures 9 d-f). Additional details about how
these procedures were implemented are provided in Appendix C.
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d. e. f.

Figure 9: Bump map examples. a.) Cones, b.) Domes, c.) Large size domes, d.) Original LiDAR
vegetation, e.) Bump mapping applied with variations in tree density between stands, f.) Additional
example of bump map with variation in stand density.

Tint bands: Tint bands can be used as a cartographic technique to form a wide band to symbolize
things such as boundaries. In this project, tint bands were used to symbolize boundaries of major
land ownership. Property boundary identification is important to Hood River County Forestry
Department staff and it is equally important that they convey this information accurately to
recreation users and map readers. It is important to make sure recreation activities are consistent
with regulations for each ownership type (i.e. County, State, and Federal) as well and restricting
infringement on private property.

The process of creating tint bands requires multiple steps but provides a cartographic representation
that is not directly available through standard line symbology settings or through development of
polygon (i.e. boundary) buffering techniques. The first step in the process was to dissolve property
parcels that were owned by one particular landowner. All Hood River County, State of Oregon, and
U.S. Forest Service parcels were identified and merged by distinct owner. Also, all privately owned
parcels were dissolved into one large multipart polygon. Next, the tint bands were created using
techniques that are described in more detail in Appendix D. Developing tint bands of the best width
for cartographic purposes required testing of several different widths. A model was developed in
ESRI’s Model Builder so that small manipulations could be made and the model re-run without
having to manually redo all of the geoprocessing tasks with each test (Figure 10). The finished
products were tint bands that provide a cartographic representation that can be adjusted with respect
to desired color and transparency (Figure 11).
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11: Example of tint bands representing ownership boundaries (shown in yellow, green,
purple, and orange).

Feature-linked annotation: Feature-linked annotation feature classes were used to develop map
labels/text for several layers. In some cases this required custom vbScript expressions to combine

multiple attribute fields into a single text string based on IF/THEN statements. For example, this
was used for trail name labels (Figure 12).
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Trail Name annotation has bicycle
style (XC or FR) only if it is a bicycle

trail with a designation. This is
A determined by vbScript IF/THEN
(| statement.

Function FindLabel ( [Name], [Bikestyle] )
If IsNull ([Bikestyle]) Then
FindLabel = [Name¥
Else
FindLabel = [Name] & " (" & [Bikestyle] & ")"
End If
End Function

Figure 12. Example of custom annotation from vbScript IF/THEN statement as seen a.) in the map,
and b.) as a code example.

Creating custom symbols and Style References: Development of custom symbols was necessary for
certain cartographic effects (Figure 13). Symbols were compiled into a Style Reference so that they
could be easily shared among team members. This ensured consistency in the cartographic
representation seen on each member’s screen. The procedure used to share Style References is
provided in Appendix E.

DH * u “ ®
(B-E’b Difficulty Black  Difficulty Blue | Difficuity ™ Difficulty Green
Advanced Intermediate  Double Black Beginner
i Diamond

Figure 13: Examples of custom symbols that were created and stored in a custom Style Reference.

Representations: In some cases, feature class representations were required to generate the desired
cartographic effect. Representations allow fine tuning of the cartographic ‘representation’ of
features to obtain a desired visual effect without actually modifying the underlying feature class
data in the geodatabase. This is ideal when you need to manually adjust the placement of specific
features or their draw order, but do not want to change the data itself (Figure 14, a and b).
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Figure 14: Example of using representation for a desired cartographic effect as seen in the before
image (a) and the after image (b).

Variable depth masking to improve annotation display: Variable depth masking is a technique that
uses a mask layer that is essentially a polygon generated around each piece of annotation. The user
defines the layers that will be ‘masked’ (i.e. visually obscured) by the mask polygon. This
technique was used with annotation in layers such as roads, trails, and contours (Figure 15).

\

with trail symbol (dashed
3 line) masked.

Road number
annotation uses
masking technique.

£

Figure 15: Examples of varible depth masking in combination with annotation.

Use of reference grids: Reference grids can be used by the map reader for orientation, particularly
when used in concert with GPS coordinates while in the field. Two separate reference grids were
used in the map, including a latitude/longitude grid and a UTM grid (Figure 16).
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Figure 16: Reference grids for Lat/Long (pink) and UTM (blue) along with their respective grid
labels along the map border.

Stream Symbology and Labeling: The stream file began as a Hood River County layer with 839
features that was first clipped to just beyond our extent, resulting in 128 features. Once the streams
phenomena was viewed in the map in relation to the other data, it was clear that they did not line up
with some of the base layer data as shown in Figure 17a and Figure 17b. In Figure 17b, the stream
has been edited to ‘follow’

N .

.a. | b.
Figure 17 (a and b): Stream Not Edited and Stream Edited to match LiDAR data.

The streams initially lined up with one of the hillshades because they too were created from NED
10 meter DEM. The NED 10 meter DEM (and therefore its hillshade) was the best available digital
elevation model for generating stream centerlines on the regional scale. That is, when someone at
the State of Oregon created a stream centerline dataset, they took the best available DEM (the
USGS NED 10-meter resolution DEM) and produced stream centerlines for the State of Oregon that
were subsequently adopted by Hood River County. This scenario is similar for Washington and
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many other states since the 10-meter DEM is the best available complete DEM for the continental
USA. However, LIDAR is now available but only in certain areas. It is not available for the entire
state. This means it is impossible to use it to create an improved statewide hydro dataset(s). The
LiDAR is 3 ft resolution compared to the roughly 32.8 foot (i.e.10 meter) DEM resolution. If
necessary and time allowed, the LIDAR data could be used to perform hydro modeling and to
develop very accurate location of the centerlines (where LIDAR is available). It was logical that the
streams lined up with the NED DEM (hillshade) because they were both derived from the same
dataset. This creates a visual problem. To resolve this issue, a table was exported from the clipped
streams layer to use as a physical (paper and pencil) ‘check-off” sheet as each stream was edited
within the geodatabase to match the visualization of the LIDAR data. As each stream was edited, it
was checked off as completed. Another issue with the stream layer was instances of labels such as
‘<Name of Stream> Cr.” ‘<Name of Stream> Cr,” and ‘<Name of Stream> Creek’ for creeks as
shown in Figure 18.

Table -
=N L L.
Strearn
| | oBsEcTiD* | Shape* — NAME TYPE CODE | TYPETEXT
|| 692 | Polyline Camp il;[eg._t:: Stream | Stream
|| 877 | Polyline Green PointCr.) Stream | Stream
| 672 | Polyline Morth Fork Green PointTr, ) Stream | Stream

Figure 18: ‘Creek’, ‘Cr,” and ‘Cr.” issue.

A new text field was created, to which ‘NAME’ was copied. Through a series of selections and
short python code (NAME!.replace("Cr,","Creek" for example)) all instances of ‘Cr,” and ‘Cr.’
were changed to ‘Creek’ for consistency. It should be noted that this issue should have been
resolved at data entry. Upon completion of stream editing, Maplex was selected as the label editing
engine and labels were placed for each part. While this produced far more labels than necessary, it
provided a good choice from which to choose appropriate labels. In addition, using Maplex the
Label Repetition was utilized so that even more labels were created. During final editing, extra
labels were deleted. Labels were placed using ‘River Placement’ (Curved), ‘Offset’ from the line
(stream) by 1 point and allowed to overrun the feature. The minimum feature size for labeling was
two inches; labels were NOT allowed to ‘stack’ and were set to ‘Follow’ the feature for easier
placement and editing. The labels were converted to annotation that was stored within the Stream
Geodatabase. This is important to note because ArcGIS Desktop Standard is the minimum
requirement for editing feature-linked annotation or other types of relationship classes. Every
stream label required a placement modification so that it was not overlapping another important
feature. During final editing (when all features and feature labels/annotation are on the map), it is
likely that minor modifications will be necessary to create a high quality document.
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Testing & Results

For our project, we tested different trail database designs, various map layouts, and online map
products. Through these processes we determined what would be the best approach for Hood River
County to implement.

Trail Database Design

Trail geodatabase development occurred through a process of design and testing. The first step was
to scope the needs of HRCFD in terms of their trail data and map needs. With this complete, we
were able to start conceptualizing ideas about necessary database elements (Figure 19). Next, we
proceeded to build the geodatabase and define its properties in ArcCatalog. A subtype field was
applied and several attribute domains were developed to improve consistency and quality control
during data entry. A benefit of using subtypes is that it allows default behaviors to be established
for each field in the attribute table based on a particular subtype. This generally decreases the
amount of time required during data entry and therefore will provide workflow efficiencies for the
HRCFD personnel. After a significant amount of data scrubbing and cleanup of the HRCFD’s
existing trail shapefile(s), we were able to import the data into our new trail feature class. The
geodatabase feature classes were edited in test mode (i.e. with backup copies) to ensure that
subtype, domains, and default behaviors were working as intended. As we continued to work with
the geodatabase there were several instances where additional fields needed to be added and
assigned accordingly for default behaviors. There were also several instances where we use
ArcToolbox geoprocessing tools to modify domain value lists to either add or remove values from
the lists.
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Figure 19: Brainstorming of geodatabase design elements

Trail Map

During the creation of our map products we used a strategy of dividing up data development
activities. Each team member took responsibility for one particular data theme at a time, be it trails,
roads, contour lines, streams, water bodies, boundaries (of ownership, wilderness, scenic areas), etc.
As each dataset was prepared for representation, feature-linked annotation was created and
meticulously edited to place labels following cartographic best practices and with visual appeal and
readability in mind. As dataset packages were finished and shared back among team members,
minor adjustments were sometimes needed to fix overlaps (such as annotation overlaps) between
datasets or other small manipulations to improve cartographic representation.

The process of developing all of the map elements including the feature symbols, annotation,
layouts, and a host of other map elements, required constant testing and refinement. As the
cartographers we were responsible for determining appropriate symbol types, colors, sizes, fonts,
positioning, classification schemes, brightness, contrast, transparencies, etc. On many occasions
drafts of the map were exported to digital copies for review and/or printed to ensure that the desired
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visual effect was being achieved. After developing a conceptual layout for the map (Figure 20), we
were able to make decisions about paper size, project area, and the appropriate scales of the main
map and any inset maps. Many of these decisions required careful consideration and conversations
with the project sponsor to determine their interests (e.g. discussing printing costs when considering
different paper sizes). We experimented with several different prototypes before reaching the final
size, configurations, and layout. The finished map provides the best balance on many cartographic
best practices and decisions (Appendix F).
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Figure 20: Conceptual map layout

ArcGIS Online Prototypes

In our attempts to provide suggestions for further study and analysis for a sustainable trail
management system, we experimented with two approaches to web mapping. For the first web map,
we tried publishing and hosting a feature service using a shapefile. For the second web map, we
instead tried publishing and hosting a feature service using an ArcMap document. Both methods
have their benefits and drawbacks. Choosing a method to implement will depend on what is
considered to be the most important and the most feasible.
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ArcGIS Online Map - Publishing a web map using a shapefile or CSV file:

Shapefiles or CSV files can be uploaded to ArcGIS.com and hosted as services in the cloud. This
can be done without ArcGIS products locally installed on the machine. All you need to do is have a
zipped shapefile that is saved to your computer. Then in ArcGIS.com the zipped shapefile can be
uploaded by adding it as an item. While a web map with a shapefile is very easy to create, it has
limited capabilities. Publishing a hosted feature service from ArcGIS.com using a shapefile, can
only support files that are smaller than 10 MB meaning only small .zip shapefiles and CSV files
containing less than 1,000 features can be added to the web map. The zipped shapefiles are easy
when you only want to display a simple and small feature on the map (Figure 21).
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Figure 21: Example Trail Web Map with Shapefl

ArcGIS Online Map - Publishing a web map using an ArcMap document:

An ArcMap document can be published as a feature service and hosted in the cloud using
ArcGIS.com. To publish an ArcMap document, first create the map document (.mxd) with the
layers displayed how you would like them to be shown in the web map (Figure 22). Scale and
symbolize the layers accordingly. Even though a basemap will be used in the final ArcGIS.com
map, it cannot be published as a map service with an ArcGIS.com basemap in the map document.
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Figure 22: ArcMap Document to be published as a Map Service

Once the map document contains all of the desired web map layers, it must be ‘Analyzed’ to see if
the map can be published as a service (File > Analyze Data...). Analyzing the map examines
drawing errors, warnings, and messages that could potentially impact the drawing performance. For
example, an error appears if the data layers are not in the correct coordinate system for ArcGIS.com
(WGS_1984 Web_Mercator_Auxiliary_Sphere). Other errors can occur if the symbology is not
supported in ArcGIS.com. If errors exist, error messages will appear in a new window. Right-
clicking on an error will explain the conflict and provide ways to resolve the issue. If there are
errors they will need to be examined and fixed before the map can be published as a service. Once
the errors have been fixed, the map can be shared as a map service on the University of Washington
Department of Geography server. In ArcGIS.com, the map service can be loaded with all of the
layers that were previously in the map document (Figure 23). The layers in the web map will be
symbolized and shown exactly how they were specified. The map service created from an ArcMap
document supports larger datasets, feature classes, and annotation feature classes. While this
approach provides a lot more interactive and design capabilities, an ArcGIS Server is needed in
order to create a map service.
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Figure 23: A Zoomed Out and Zoomed In View of the ArcGIS Online Trail Map

Implementation Plan

This project is unique in that there is one specific deliverable (an updated cartographic
representation of the HRC Recreational Trail System) and a recommended plan of further action
(Figure 24) for the County to more effectively maintain their system of sustainable logging areas
which double as a recreational area.

A cartographic representation has been presented to HRCFD, and is currently under review in a
process that will outlast the length of GEOG 569. It should be noted that the project team has
committed to Mr. Buckalew that we will work with him and the County to make any and all
necessary edits to the document as the review process moves forward. The project team has
developed a completed hard copy map (still in draft form) with the updated data that has been
received to date from the project sponsors.

For HRC to implement the cartographic representation (Print the Map), the map should be edited to
satisfaction by the HRCFD staff and then sent out to ‘people of the place’ to provide input. While
the county would have final say, it is important to hear from community groups, recreational trail
users, businesses and other entities involved with the HRC Trail System Master Plan. To implement
the final recommended version of our design, we will plan to take the elements from the map layout
brainstorm and put them into the final hardcopy map. While the data maintenance and cartographic
representation have been very time consuming and tedious, the project sponsors will benefit from
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having an updated non-motorized trail map, an updated trail database, and a map document that can
be used as a template for future updates.

In order for the project sponsors to implement the recommended trail design for the future, we plan
to provide the project sponsors with all of the necessary databases and map documents that were
used to create the final product. For maintaining the trail database, it would be helpful to have
someone who can take ownership of it in order to make sure that it gets updated accurately. It would
be recommended for the HRCFD to train the staff on how to add, maintain, or delete data according
to the trail database design. It would be very beneficial and recommended for the trail data to be
updated on a regular basis, and as it gets updated via field work. This will prevent the trail database
from getting outdated and will make it easier to update the non-motorized trail map in the future.

For implementing the web map using a shapefile, the HRCFD could simply create and export a
zipped shapefile or CSV file, store it on a hard drive and upload it to an ArcGIS Online map. If the
HRCFD decided to implement the proposed web maps created with a map document, it would be
recommended for the county to invest in an ArcGIS Server. The decisions involved in this portion
are beyond the scope of the project, specifically because we were asked to focus on creating a print
ready map and to provide suggestions for data management and future map development. However
it is included because of our suggestion for further study and it is something for them to consider.
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The GIS data management aspect of the project was focused on a business process improvement for
HRC. By definition, a ‘business process improvement’ is a situation in which business processes are
tuned or modified to increase performance using incremental and continuous changes to process
where modifications happen more slowly but continuously and frequently (McKibben & Pacatte,
2003). We set out to provide a series of recommendations to help improve the HRCFD workflow.
Harmon states: “the first phase of any process change project is to define the project itself, consider
possible solutions and then make a recommendation about what level of effort and budget will be
needed to solve the problem (Harmon, 2007). In addition, this is not a bottom up methodology;
there is full involvement and support from the ‘Senior Management’ (project Sponsor— Mr.
Buckalew) (McKibben & Pacatte, 2003). As such, with the support of Mr. Buckalew we have
developed a list of suggestions in order to implement our trail design as well as sustainable
management ideas.

1. Upgrade the current software (2 licenses) from ArcView 10.0 to a concurrent license of
ArcGIS Desktop Standard 10.2 (formerly known as “ArcEditor” in versions prior to 10.1)
that can be used by both Mr. Buckalew and the Forestry Office Manager. There are multiple
benefits in upgrading to this version that will facilitate data management and editing. At the
ArcGIS Desktop Basic license level (formerly known as “ArcView”), users are able to edit
annotation stored in a map document (.mxd), or view annotation stored in a geodatabase, but
are restricted from editing geodatabase annotation. Because there are many benefits to
storing and managing annotation in a geodatabase, and because all of the annotation
developed for this project is stored this way, we are recommending the upgrade to the higher
license level so that staff has the ability to edit annotation as needed for future map projects.
With an upgrade to any of the ArcGIS license levels that are version 10.1 or newer, users
gain access to the Maplex labeling extension. This extension was previously only available
at no cost at the ArcGIS Desktop Advanced license level (formerly known as Arclnfo), or
through an additional purchase of the extension for $2500. The Maplex extension provides
a sophisticated labeling engine that improves the ability to generate labels and new
annotation. The approximate initial cost for the upgrade to ArcGIS Desktop Standard is
$7000 with a $1500 per year maintenance fee.

2. Add a concurrent license of the Spatial Analyst Extension from Esri. Spatial Analyst will
provide a plethora of tools that are useful for analysis and generation of additional datasets.
Spatial Analyst includes tools that are required to perform the ‘Bump Mapping’ techniques
used in this project. Spatial Analyst also provides tools for generating hillshades, contours,
and a host of other datasets and would be useful to HRCFD when used in concert with their
LiDAR data. The initial cost for this extension is $2500, and there is a $500 per year
maintenance fee.

3. Instead of using shapefiles, it is recommended that HRCFD begin using feature classes
stored within geodatabases and perhaps organized within feature datasets. Files are being
returned to HRCFD in many separate geodatabases so that they can be easily edited and
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maintained as necessary. There are only slight procedural changes between feature classes
and shapefiles, and the benefits outweigh the short learning curve.

4. A significant reduction in data entry time will be achieved if HRDFD utilizes the subtypes
and domains that have been developed for several data sets. It is also recommended that
HRCFD create subtypes and domains in new datasets as appropriate. The use of these items
will also reduce data entry error (thus saving additional time that would have been required
to ‘fix’ the errors).

5. Moving forward, it is suggested that HRCFD maintain one dynamic dataset for each specific
phenomena, rather than create duplicate shapefiles or feature classes for each new task. With
domains and subtypes, data quality can be maintained with less chance of corruption.

6. Back-up copies of all data should be housed off location, perhaps on a server and/or in the
cloud. Data should be backed up daily.

Financial Analysis

As noted by Mr. Buckalew, the county has very limited staff and financial resources that they can
devote to recreation management. The use of GIS has already eased some of the burden in terms of
managing an inventory of the trail system. The importance of a quality map product was
emphasized because of how many people use it. Mr. Buckalew noted that the map is “heavily used
by our own Forestry staff and recreationists.” HRCFD provides maps to users via the county office,
outdoor retailers, as well as in the forest at some of the staging areas. Recreation tourism is an
important component of HRC economy, and promoting sustainable trail recreation serves many
social, economic and health benefits within the community. Mr. Buckalew noted that the ability to
wisely and sustainably manage the trail system starts with having a good inventory of trails and a
good map. In creating a quality map, HRC would be more likely to be awarded in-kind matches
toward grants that HRCFD manages for recreation trail improvement projects. While the reasoning
behind the production of a new map and improved workflows seem obvious from the Project
Questionnaire and in speaking with Mr. Buckalew, it is important to complete a thorough financial
analysis of the proposed GIS improvements and creation of the cartographic deliverable to the

County to determine if the changes are financially beneficial.

The development of this ‘top-down - business process improvement’ stipulates only minimal
financial outlays. However, it is imperative to consider and document whether there will be any
significant costs incurred with the advent of the suggested changes and if the costs will be offset by

the business process improvements in the form of streamlined (more efficient) workflows, increased
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revenue and other monetary advantages. Nancy Lerner’s ‘Business Process Analysis/Modeling for
Defining GIS Applications and Uses’ was utilized as a template and guide to analyze the financial
aspects of the proposed business process improvements. We utilized the ‘Future 5 Years.xls’
template provided by Lerner based on the assumption that GIS technology is rapidly changing over
time and it is very likely that in five years there will be technology in place that would require
additional financial analysis. We saved the file in the most recent .xlsx format in MS Excel 10 and
proceeded with the instructions. There are only 4 internal and zero external positions involved in

this project, as HRC Forestry Department is very small and this is not a county wide analysis.

Many assumptions were made in an attempt to complete a general financial analysis without going
outside of the original scope of the project. Unfortunately, there wasn’t an opportunity to consult
with the HRC Financial and Human Resources departments. Following the directions in Appendix
A of Lerner’s publication, variables were entered in the Project Setup Sheet as indicated in Table 2
below (Lerner & Technology Association, 2007).

Project Name: Hood River County GIS Improvement Project (HRC-GIS)

Date Analyzed: 8/3/2013

Net Present Value (Net Benefits): $308,977

Annualized Return on Investment: 242.04%

Breakeven Point: 2013

Payback Period (in Years): 0

Inflation Rate: 2.47%

Opportunity Cost of Capital: 5.00%

Project Year Labels: [ 2013 | 2014 | 2015 | 2016 | 2017 |
Project Life (Number of Years): 5

Method for Determining Future Years' Cost of Labor:
Derived by Applying Inflation Rate to Current Costs

Notes and Other Assumptions:
Project will be implemented in year one (2013) and continue for five years.

Table 2: Project Setup Sheet

While some of the values are entered automatically from other sheets in the excel document, some

were entered manually:
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e Inflation 2.47% (based on the average inflation over the past 10 years as reported on the
http://data.bls.gov website) (D. o. L. United States, 2013).
Opportunity Cost of Capital: 5% (as suggested by the spreadsheet/directions)
Project year labels 2013 — 2017
Method for Determining Future Years’ cost of Labor: Derived by Applying Inflation Rate to
Current costs (as recommended by the spreadsheet/directions)

NPV (Net Present Value) was chosen (as opposed to ROI) as the key metric in this analysis. NPV is
more straightforward, ROI can be somewhat deceptive and cannot be used in comparing mutually
exclusive investments (Gardner, Gould, & Jumawan, 2012). Because we are going under the
assumption that NPV is the more acceptable metric, we decided to not treat any of our internal labor
costs as a negative productivity benefit (Lerner & Technology Association, 2007).

The ‘Financial Analysis’ sheet will be discussed later in this document because the values herein are

based on twelve other sheets in the file.

Four types of Job Categories were entered into the Labor Rates worksheet. Trails Program
Coordinator/Forest Technician Il (Mr. Buckalew), Forestry Office Coordinator, part time Forestry

Technicians and GIS Director, with approximated salary values as shown below in Table 3.

Current Average Average Average

Average Annual Annual Cost|Annual Average Average

Hourly Rate Burdened [Regular Before Overtime Overtime Annual Cost
Job Category ($/Hour) Fringe Hourly Rate |Hours Overtime Hours Multiplier [of Position
Trails Coordinator/Forestry Tecn $40.00 33.00% $53.20 2080 $110,709.20 0 $110,709.20
Foresty Office Coordinator $20.00 33.00% $26.60 2080| $55,354.60 0 $55,354.60
Forestry Technician I's $12.00 33.00% $15.96 2080| $33,212.76 0 $33,212.76
GIS Director $60.00 33.00% $79.80 2080| $166,063.80 0 $166,063.80

Table 3: Labor Rates Worksheet

Approximate wages and fringe were entered, and because overtime is not currently authorized
within the county, it was not included in this analysis. Fringe (a wage multiplier that covers the cost
of taxes, insurance, and related overhead items that contribute to the cost of each employee) was set
at 33% for all positions to replicate the Lerner example (Lerner & Technology Association, 2007).

All other work on the trail system is volunteer work.

In the ‘Labor Cost Multipliers” worksheet, (Table 4) ‘per hour’ was selected as the default basis for
labor costs, nothing else was changed in this worksheet.
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Method for Determining Future Years' Cost of Labor: Derived by Applying Inflation Rate to Current Costs

Current Current Valuation 2013 2014 2015 2016 2017
Job Category Hourly Rate |Cost/FTE Method Labor Cost | Labor Cost| Labor Cost | Labor Cost| Labor Cost
Trails Coordinator/Forestry
Tecnician Il $53.20| $110,709.20|per Hour $53.20 $54.51 $55.86 $57.24 $58.65
Foresty Office Coordinator $26.60| $55,354.60|per Hour $26.60 $27.26 $27.93 $28.62 $29.33
Forestry Technician I's $15.96] $33,212.76|per Hour $15.96 $16.35 $16.76 $17.17 $17.60
GIS Director $79.80| $166,063.80|per Hour $79.80 $81.77 $83.79 $85.86 $87.98
Valuation Method Options Description
per Hour Labor cost reflects averge cost per hour worked
per FTE Labor cost reflects average annual cost of one full time position

Table 4: Labor Cost Multipliers

In the ‘Internal Labor Usage’ worksheet, the nature of the work was entered as well as the total of
all labor hours for the category was entered in the corresponding years. It is estimated that fifty
hours will be required on the part of Mr. Buckalew, one hundred hours by the Office Manager, and
zero hours by the part-time Forestry Technicians and ten hours by the Hood River County’s GIS
Director. The reasoning behind this is there are not many new tasks nor many drastic changes to the
workflow, and all changes will be beneficial to productivity. Once the change in workflow is
adopted and the map product is produced, there will be no additional work time to implement the
suggested changes. The expected hours required for the implementation of the recommendations are

documented in ‘Internal Labor Usage’ worksheet (Table 5) below.

Valuation 2013 2014 2015 2016 2017
Job Category Method Nature of Work Hrs or FTEs | Hrs or FTEsS | Hrs or FTEs | Hrs or FTEs | Hrs or FTEs
Trails Coordinator/Forestry
Tecnician Il per Hour  [Managing the Project, Data work 50.00
Foresty Office Coordinator per Hour  |Data Entry 100.00
Forestry Technician I's per Hour  [Data Collection 0.00
GIS Director per Hour  |GIS Upgrades and Conversion 10.00

Table 5: Internal Labor Usage.
The hours listed above result in the costs shown from the ‘Internal Labor Costs’ worksheet (Table

6). A total of $6,118 dollars of internal labor costs will be required for the workflow

implementations.
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(in future year dollars) $2,013 $2,014 $2,015 $2,016 $2,017
Job Category Labor Cost Labor Cost Labor Cost Labor Cost Labor Cost
Trails Coordinator/Forestry
Tecnician Il $2,660 $0 $0 $0 $0
Foresty Office Coordinator $2,660 $0 $0 $0 $0
Forestry Technician I's $0 $0 $0 $0 $0
GIS Director $798 $0 $0 $0 $0
Total Internal Labor Costs $6,118 $0 $0 $0 $0
|Tota| Iternal Labor Investment | $6,118|

Table 6: Internal Labor Costs

The ‘Contract and Procurement Costs’ worksheet (Table 7) was used to record all one-time and

ongoing project costs in each of the respective categories. The recommendations included

upgrading from two ArcView (ArcGIS Desktop Basic) licenses to either two ArcEditor (ArcGIS

Desktop Standard) licenses or a concurrent license. It is also recommended that the HRCFD

purchase the Spatial Analyst extension so that they have the capability to perform complex analysis

(BumpMaps) in the future on their own. It is also recommended that the Maintenance Agreement be

maintained for all ArcGIS software throughout the five years. The printing of the maps was not

included because the costs will be fully covered by an existing grant and the document will have a 5

year lifespan (the time designated for this financial analysis).

(in future year dollars) 2013 2014 2015 2016 2017
Staff development and training
Esri Virtual Campus: Spatial
Analyst ($160 each) $320.00
Esri Virtual Campus: Getting
Started with the Geodatabase ($32
each) $64.00
Esri Virtual Campus: Using
ArcGIS Online (Free) $0.00
Esri Virtual Campus: Getting
Started with ArcGIS (Free) $0.00
Esri Virtual Campus: Preparing to
implement an ArcGIS online
Subscription (Free) $0.00
New software
Upgrade to ArcEditor (ArcGIS
Desktop - Standard) Concurrent $7,000.00
Spatial Analyst $2,500.00
Software maintenance fees
ArcEditor (Standard) Maintenance
(Concurrent) $1,500.00 $1,500.00 $1,500.00 $1,500.00 $1,500.00
Spatial Analyst Maintenance
(Concurrent) $500.00 $500.00 $500.00 $500.00 $500.00
Total External Costs $11,884 $2,000 $2,000 $2,000 $2,000
[Total External Investment | $19,884]

Table 7: Contract and Procurement Costs
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The ‘Productivity Benefits’ worksheet (Table 8) was for review purposes only, nothing was entered

directly. The sheet is a summary, calculated as a result of the ‘Productivity Benefit Detail’

worksheets 1-4 (Tables 9, 10, 11, and 12). ‘Productivity Benefit Detail” sheets one through four

were completed based on a realistic analysis of the benefits that the deliverables for this project

have produced. Deliverables are the enhanced GIS data management and workflow modification

and the state of the art, marketable map that will be sold to thousands of visitors per year.

(in future year dollars) Valuation 2013 2014 2015 2016 2017
Job Category Method Savings Savings Savings Savings Savings
Trails Coordinator/Forestry
Tecnician Il per Hour $30,058 $30,800 $31,561 $32,341 $33,140
Foresty Office Coordinator per Hour $12,768 $13,083 $13,407 $13,738 $14,077
Forestry Technician I's per Hour $0 $8,439 $8,647 $8,861 $9,080
GIS Director per Hour $3,192 $3,271 $3,352 $3,434 $3,519
Total Productivity Benefits $46,018 $55,593 $56,967 $58,374 $59,815
Table 8: Productivity Benefits
Job Category: Trails Coordinator/Forestry
Tecnician |l 2013 2014 2015 2016 2017
Specific Productivity Benefits Hours Hours Hours Hours Hours
Reduction in Data entry error fixes (domains/subtypes),
less redundancy of datasets etc. 50.00 50.00 50.00 50.00 50.00
Reduce the amount of time required to perform data
analysis 100.00 100.00 100.00 100.00 100.00
Improve productivity by reducing travel time to investigate
problems 100.00 100.00 100.00 100.00 100.00
Enhanced management of routine tasks, rather than
'putting out brush-fires' day after day 50.00 50.00 50.00 50.00 50.00
Reduction in trail review processes 50.00 50.00 50.00 50.00 50.00
Improved tracking of trail adopters 20.00 20.00 20.00 20.00 20.00
More efficient Grant Application submissions 25.00 25.00 25.00 25.00 25.00
Enhanced management of Law Enforcement Personell 20.00 20.00 20.00 20.00 20.00
Reduction of time required for effective and efficient
Contract Operations: silvicultrual operations (thinning),
logging, trail work, planing operations, road and culvert
maintenance 100.00 100.00 100.00 100.00 100.00
Customer Senice efficiency 50.00 50.00 50.00 50.00 50.00
Total Hours Saved for this Job Category 565.00 565.00 565.00 565.00 565.00

Table 9: Productivity Benefit Detail-1
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Job Category: Foresty Office Coordinator 2013 2014 2015 2016 2017
Specific Productivity Benefits Hours Hours Hours Hours Hours
Reduction in staff training time required (simpler, more

efficient and less error during data entry) 100.00 100.00 100.00 100.00 100.00
More efficient and accurate 'mini' 'upon request' map

making 100.00 100.00 100.00 100.00 100.00
Reduction in management time required for: field crews:

GPS, timber cruisers, planting crews, restroom

cleaning/maintenance/garbage removal 30.00 30.00 30.00 30.00 30.00
Customer Senice (Walk ins) Efficiency, 5 hours per week 250.00 250.00 250.00 250.00 250.00
Total Hours Saved for this Job Category 480.00 480.00 480.00 480.00 480.00
Table 10: Productivity Benefit Detail-2

Job Category: Forestry Technician I's 2013 2014 2015 2016 2017
Specific Productivity Benefits Hours Hours Hours Hours Hours
Enhanced (more efficient) data collection. 416.00 416.00 416.00 416.00
Enhanced management of Forestry Technicians time 100.00 100.00 100.00 100.00
Total Hours Saved for this Job Category 0.00 516.00 516.00 516.00 516.00
Table 11: Productivity Benefit Detail-3

Job Category: GIS Director 2013 2014 2015 2016 2017
Specific Productivity Benefits Hours Hours Hours Hours Hours
Performing advanced Analysis, not previously available

due to the limited license. 20.00 20.00 20.00 20.00 20.00
Reduced tasks involving Repairing 'problems' resulting

from non-GIS Users 20.00 20.00 20.00 20.00 20.00
Total Hours Saved for this Job Category 40.00 40.00 40.00 40.00 40.00

Table 12: Productivity Benefit Detail-4

The ‘Other Benefits’ worksheet (Table 13) was completed with the expected non-productivity

benefits. Non-productivity benefits are minute in comparison to the productivity benefits for this

project because the project is, as noted earlier, a small business process improvement that facilitates

productivity benefits and the development of a state of the art, marketable map.

(in future year dollars) 2013 2014 2015 2016 2017
Specific Other Benefits Benefits Benefits Benefits Benefits Benefits
Sale of New Maps to \isitors (1000
per year at $15.00 each ower the
life of the map (approx. 5 years)) $15,000.00 $15,000.00 $15,000.00 $15,000.00 $15,000.00
Total Other Benefits $15,000 $15,000 $15,000 $15,000 $15,000

Table 13: Other Benefits
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As shown in Table 14 below, the results from this financial analysis provide a strong case for
pursuing the project recommendations. In 2017, the Net Present Value (chosen metric) is calculated

to be $310,434.

2013 | 2014 | 2015 | 2016 | 2017 |
Future Cash Flows
Internal Labor Costs ($6,118) $0 $0 $0 $0
Contract/Procurement Costs ($11,884) ($2,000) ($2,000) ($2,000) ($2,000)
Productivity Benefits $46,018 $55,593 $56,967 $58,374 $59,815
Other Benefits $15,000 $15,000 $15,000 $15,000 $15,000
Present Value Multiplier: 100.0% 97.6% 95.2% 92.9% 90.7%
Present Values
Internal Labor Costs ($6,118) $0 $0 $0 $0
Contract/Procurement Costs ($11,884) ($1,952) ($1,905) ($1,859) ($1,814)
Total Annual Costs ($18,002) ($1,952) ($1,905) ($1,859) ($1,814)
Cumulative Costs ($18,002) ($19,954) ($21,859) ($23,717) ($25,532)
Productivity Benefits $46,018 $54,254 $54,254 $54,255 $54,255
Other Benefits $15,000 $14,639 $14,286 $13,942 $13,606
Total Annual Benefits $61,018 $68,892 $68,540 $68,197 $67,861
Cumulative Benefits $61,018 $129,910 $198,451 $266,647 $334,508
| Cumulative Net Benefits] $43,016 | $109,957 | $176,592 | $242,930 | $308,977 |
Breakeven Year: 2013
Payback Period (in Years): 0
Net Present Value: $308,977
Present Value of Costs:  $25,532
Return on Investment: 242.04% (Annualized)

Table 14: Financial Analysis

The costs in this analysis consisted of labor, software updates and maintenance during the first year.
No further expenditures are expected (beyond the maintenance agreements, as indicated above). An

indirect and currently unquantifiable benefit is the enhanced interest in the trail system, resulting in

more than expected maps being purchased as well as increased volunteer hours and commitment

from possible corporate sponsors of the trail.

The breakeven year is 2013, and even if half of the projected benefits do not come to fruition, there
will still be a net present value of over $100,000. The numbers used in the analysis were of course

hypothetical, however, they were completed conservatively so as to not inflate or skew the results.

Additionally, it should be noted that this analysis was completed in just four days based on the HLT

team assumptions. Clearly, the small outlay of expenses and staff time is worthy of such significant

gains in productivity and revenue.
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Recommendations for Future Study & Analysis

For the future, we would like to recommend several ideas that could be used to help improve trail
design and sustainability management. In addition to hardcopy paper maps, we would recommend
further investigation of interactive web maps created on ArcGIS.com that can be hosted in the
cloud. While paper maps will always serve a distinct and necessary purpose, web maps have the
potential to provide users with information that far exceeds that which is typically available in a
paper map. For example, the ability to ‘point-and-click’ to select features in the map to access
stored information provides many additional benefits. Web maps also have the potential to provide
more current information since they can be continuously updated.

It is suggested that if the development, hosting, and maintenance of a web map is beyond the scope
of projects that HRCFD plans to implement, that HRCFD consider working with an outside
organization that may be interested in this type of endeavor. Purely for the sake of example,
HRCFD could partner with an organization such as the local non-profit Hood River Area Trail
Stewards (HRATS). This is an organization that may have a fitting organizational mission and
perhaps the funding mechanisms available to host a web map of the Hood River area trail system(s)
on its website. Some benefits of hosting this type of web service are that a map administrator could
keep the map up-to-date with current trail status and condition information. Users of the web map
could obtain additional information from the map through a point-and-click procedure. For
example, trail segments, when clicked, could provide contact information for the Trail Adopter that
is responsible for its maintenance. Or, information could be provided about its current status and
condition. The map could be used as a means to post new trail system developments or changes
while encouraging feedback from the public audience. The map could also be used as a platform to
seek funding for necessary improvements.

It is suggested that HRC create a sign inventory complete with subtypes and domains as a first
simple run of using the newer technology. It will help with management of the sign inventory, and
the trail system data as a whole in the GIS. It will also help with rescues and trail maintenance
if/when these are needed. As new trails are built more signs will be placed and then added to the
GIS data inventory.

It would behoove future researchers to incorporate research by Jeremy Wimpey who has
investigated the relationship that trail slope has to sustainability (Wimpey, 2006). Additional
Research by Wimpey is purported to expand on his Master’s Thesis, utilizing LIDAR data and
advanced (yet to be developed) scripts, models and tools (Wimpey, 2013). While Wimpey’s
Master’s Thesis discovered that the USGS and NED DEMs at 10m and 30m were insufficient to
estimate the trail characteristics with any certainty (r*2 below .5), future research with LIDAR data
has proved promising (Wimpey, 2013). He and his co-workers are looking to hire a programmer to
build some custom tools that will streamline and automate the process (Wimpey, 2013).
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Unfortunately Dr. Wimpey was traveling when we first contacted him and we were unable to obtain
any further information.

All of these ideas proposed to the HRCFD are meant to help them improve and enhance their trail
management system in order to make it more sustainable for future use.

Conclusion

This project proposes and implements database design improvements. That will help HRCFD more
efficiently manage GIS Datasets while emphasizing sustainability at several operational levels. This
project also developed a new paper map design using professional cartography, and multiple
ArcGIS.com maps to demonstrate the benefits of new mapping technologies that leverage the intent
to expand upon capabilities of the static paper map. While all of the implemented items are
considered to be works-in-progress at this time, we believe they provide significant progress toward
items that will help HRCFD achieve its sustainability management goals.
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APPENDICES

Appendix A - Data Sources Spreadsheet

Flag "Data Sources
GIS data website
By By By [data location or direct
Rick Greg Alyssa|type |File Location File Name (as stored in data directory) | Type of File|Agency name |[source
base |C:\HRC_TrailMap\Data\basedata
State of OR/
C:\HRC _TrailMap\Data\basedata\aeria\NAIP_201 Oregon State http://oregonexplorer.info
base [1\OregonimageryWebService\ NAIP_2011_NAIP_2011_SL.lyr Layer File University /IMAGERY /home_imagery
C:\HRC_TrailMap\Data\basedata\aeria\NAIP_201 http://oregonexplorer.info
base [1\OregonimageryWebService\ NAIP_2011_NAIP_2011_WM.lyr Layer File " (Same as above) |/IMAGERY/home_imagery
C:\HRC_TrailMap\Data\basedata\aerial\NAIP_201 http://oregonexplorer.info
base |1 \Oregonlmagery.gdb Geodatabase |" (Same as above) |/IMAGERY/home_imagery
C:\HRC_TrailMap\Data\basedata\aerial\NAIP_201 http://oregonexplorer.info
base [1\Oregonimagery.gdb\ NAIP2011_NW_Area Raster " (Same as above) |[/IMAGERY/home_imagery
base |C:\HRC_ TrailMap\Data\basedata\lidar\Contours Folder
C:\HRC_TrailMap\Data\basedata\lidar\Contours\C
base |ontours.gdb Contours.gdb Geodatabase

base

C:\HRC_TrailMap\Data\basedatal\lidar\Contours\C
ontours.gdb\Contour_100

Contour_100

Feature Class

base

C:\HRC_TrailMap\Data\basedata\lidar\Contours\C
ontours.gdb\Contour_500

Contour_500

Feature Class

base

C:\HRC_TrailMap\Data\basedatal\lidar\Contours\C
ontours.gdb\Contour_500

Contour_500Anno

Feature Class

C:\HRC_TrailMap\Data\basedata\lidar\Contours\C

base |ontours.gdb\dem BE projectarea dem BE projectarea Raster
C:\HRC_TrailMap\Data\basedatal\lidar\Contours\C

base [ontours- 500 & 100.lyr Contours- 500 & 100.lyr Layer File
C:\HRC_TrailMap\Data\basedata\lidar\BumpMap.g

base |db BumpMap.gdb Geodatabase
C:\HRC_TrailMap\Data\basedata\lidar\BumpMap.g

base |db\BumpDEMminusBE2 BumpDEMminusBE2 Raster
C:\HRC_TrailMap\Data\basedata\lidar\BumpMap.g

base [db\MosaicHilshade2 MosaicHillshade2 Raster

base

C:\HRC_TrailMap\Data\basedata\lidar\BumpMap.g
db\SaleUnits_2008T02013

SaleUnits_2008T02013

Feature Class

Obtained directly from

base |C:\HRC_ TrailMap\Data\basedata\lidar\ HRC_LiDAR_Mosaic.gdb Geodatabase |Hood River County |agency
C:\HRC_TrailMap\Data\basedata\lidar\HRC_LiDAR Obtained directly from
base | Mosaic.gdb\ dem BE Raster Hood River County |agency
C:\HRC_TrailMap\Data\basedata\lidar\HRC_LiDAR Obtained directly from
base | Mosaic.gdb\ dem FF Raster Hood River County |agency
C:\HRC_TrailMap\Data\basedata\lidar\HRC_LiDAR Obtained directly from
base | Mosaic.gdb\ dem FF_minus_BE Raster Hood River County |agency
C:\HRC_TrailMap\Data\basedata\lidar\HRC_LiDAR Obtained directly from
base |_Mosaic.gdb\ hillshade_BE Raster Hood River County |agency
C:\HRC_TrailMap\Data\basedata\lidar\HRC_LiDAR Obtained directly from
base | Mosaic.gdb\ hillshade_FF Raster Hood River County |agency
base |C:\HRC_ TrailMap\Data\basedata\lidar\ FF_minus_BE VegSymbology.lyr Layer File Created
base |C:\HRC TrailMap\Data\basedata\ned\ NED.gdb Geodatabase |USGS NED http://ned.usgs.gov/
base |C:\HRC_TrailMap\Data\basedata\ned\NED.gdb\ NED_10M HRC_CoordSys_zFeet_dem Raster USGS NED http://ned.usgs.gov/
base |C:\HRC_TrailMap\Data\basedata\ned\NED.gdb\ NED_10M HRC_CoordSys_zFeet_hs Raster USGS NED http://ned.usgs.gov/
base |[C:\HRC_TrailMap\Data\basedata\ned\NED.gdb\ NED_30M _HRC_CoordSys_zFeet_dem Raster USGS NED http://ned.usgs.gov/
base |C:\HRC_ TrailMap\Data\basedata\ned\NED.gdb\ NED_30M HRC CoordSys_zFeet_hs Raster USGS NED http://ned.usgs.gov/
base |C:\HRC_ TrailMap\Data\basedata\scans\ AdventureMaps_CO_Back.TIF Raster Created / Scanned
base |C:\HRC_TrailMap\Data\basedata\scans\ AdventureMaps_CO_Front.TIF Raster Created / Scanned
base |C:\HRC_TrailMap\Data\basedata\scans\ AdventureMaps_HR_Back.TIF Raster Created / Scanned
base |[C:\HRC_ TrailMap\Data\basedata\scans\ AdventureMaps_HR_Front. TIF Raster Created / Scanned
GPNF_Map_BackPage_ExampleindexTableAn
base |C:\HRC_TrailMap\Data\basedata\scans\ dindexMap.TIF Raster Created / Scanned
base |C:\HRC TrailMap\Data\basedata\scans\ GreenTrails_HR_Back.TIF Raster Created / Scanned
base |C:\HRC_TrailMap\Data\basedata\scans\ GreenTrails_HR_Front.TIF Raster Created / Scanned
base |C:\HRC_TrailMap\Data\basedata\scans\ HRC_RoadMap_Back.TIF Raster Created / Scanned
base |C:\HRC_TrailMap\Data\basedata\scans\ HRC_RoadMap_Front.TIF Raster Created / Scanned
base |[C:\HRC_ TrailMap\Data\basedata\scans\ HRC TrailMap_Front.TIF Raster Created / Scanned
base |C:\HRC_ TrailMap\Data\basedata\scans\ HRC_TrailMap_Front_Blow up.tif Raster Created / Scanned
base |C:\HRC_ TrailMap\Data\basedata\scans\ USFS_CRG_East.TIF Raster Created / Scanned
base [C:\HRC_TrailMap\Data\basedata\scans\ USFS_CRG_West.TIF Raster Created / Scanned
Obtained from Skamania
County but originally
dow nloaded froma
USGS via Skamania |currently unknow n
base [C:\HRC_TrailMap\Data\basedata\topo\ USGS_Topo.gdb Geodatabase | County source w ebsite.
C:\HRC_TrailMap\Data\basedata\topo\USGS_Top USGS via Skamania
base [o.gdb\ HoodRiverCounty_Mosaic Raster County " (Same as Above) "
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Flag "Data Sources
GIS data website
By By By [data location or direct
Rick Greg Alyssa|type [File Location File Name (as stored in data directory) | Type of File[Agency name _|source
geo |C:\HRC_TrailMap\Data\geodata
geo |C:\HRC_TrailMap\Data\geodata\cartography\ Clip_Rectangle.shp Shapefile Created
C:\HRC_TrailMap\Data\geodata\cartography\Max
geo |ProjectArea MaxProjectArea.shp Shapefile Created
C:\HRC_TrailMap\Data\geodata\cartography\Ow n
geo |ershipGeneralized Ow nershipGeneralized.gdb Geodatabase |Created
C:\HRC_TrailMap\Data\geodata\cartography\Wate
geo |rbody_vignette WaterbodyVignette.gdb Geodatabase [Created
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary Folder
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\CRG National Scenic Area.lyr CRG National Scenic Area.lyr Layer File
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\CRG_National Scenic_Area.gdb CRG_National_Scenic_Area.gdb Geodatabase |Alyssa Created
Alyssa Created
C:\HRC_TrailMap\Data\geodata\hr_county\Bound from
ary\CRG_National_Scenic_Area.gdb\CRG_Nation NSA_Boundary_As
geo |al_Scenic_Area CRG_National_Scenic_Area Feature Class|Line
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
ary\CRG_National_Scenic_Area.gdb\CRG_Nation
geo |al_Scenic_AreaAnno CRG_National _Scenic_AreaAnno Feature Class |Alyssa Created
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\MtHoodNatForest.lyr MtHoodNatForest.lyr Layer File
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\MtHoodNatForest.gdb MtHoodNatForest.gdb Geodatabase
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\MtHoodNatForest.gdb/MtHoodNatForest MtHoodNatForest Feature Class
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\MtHoodNatForest.gdb\MtHoodNatForestAnno | MtHoodNatForestAnno Feature Class
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\OregonStateParks.lyr OregonsStateParks.lyr Layer File
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\OregonStateParks.gdb OregonStateParks.gdb Geodatabase
C:HRC_TrailMap\Data\geodata\hr_county\Bounda
geo |ry\OregonStateParks.gdb\OregonStateParks OregonStateParks Feature Class
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
ary\OregonStateParks.gdb\OregonStateParksAn
geo |no OregonStateParksAnno Feature Class
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\Wilderness.lyr Wilderness.lyr Layer File
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\Wilderness.gdb Wilderness.gdb Geodatabase |Alyssa Created
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\Wilderness.gdb\WildernessAnno WildernessAnno Feature Class |Alyssa Created
C:\HRC_TrailMap\Data\geodata\hr_county\Bound
geo |ary\Wilderness.gdb\WildernessBoundary WildernessBoundary Feature Class
C:\HRC_TrailMap\Data\geodata\hr_county\CityLim Obtained directly from
geo |its Folder Hood River County |agency
C:\HRC_TrailMap\Data\geodata\hr_county\CityLim
geo |its\CityLimits.gdb City Limits.gdb Geodatabase [Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\CityLim
geo |its\CityLimits.gdb\City Limits City Limits Feature Class |Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\County
geo |Boundary Folder Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\County
geo |Boundary\CountyBoundary.gdb CountyBoundary.gdb Geodatabase [Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\County
Boundary\CountyBoundary.gdb\HRC_Boundary_
geo |ParcelEdgeMatched HRC_Boundary_ParcelEdgeMatched Feature Class |Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\County
geo |Boundary\CountyBoundary.gdb\OregonCounties |OregonCounties Feature Class|Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\County
Boundary\CountyBoundary.gdb\OregonCounties
geo | HRC ONLY OregonCounties HRC_ONLY Feature Class |Hood River County |" (Same as Above) "
geo |C:\HRC_TrailMap\Data\geodata\hr_county\Hydro Folder Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Hydro\
geo |Streams.gdb Streams.gdb Geodatabase |Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Hydro\
geo |Streams.gdb\Stream Stream Feature Class |Hood River County |" (Same as Above) "
geo |C:\HRC_TrailMap\Data\geodata\hr_county\Hydro |Stream Shapefile Hood River County |" (Same as Above) "
geo  |C\HRC_TrailMap\Data\geodata\hr_county\Hydro |Stream Clip.lyr Layer File Hood River County |" (Same as Above) "
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Flag

By By By
Rick Greg Alyssa

“Data Sources

data
type

File Location

File Name (as stored in data directory)

Type of File

Agency name

GIS data website
location or direct
source

C:\HRC_TrailMap\Data\geodata\hr_county\Hydro\

Obtained directly from

geo |Streams.gdb\Stream Clip Stream_Clip Shapefile Hood River County |agency
C:\HRC_TrailMap\Data\geodata\hr_county\Hydro\
geo |Streams.gdb\Stream _Cart_Clip Stream _Cart_Clip Shapefile Hood River County |Created from above
C:\HRC_TrailMap\Data\geodata\hr_county\Hydro\
geo |Streams.gdb\Stream Cart_ClipAnno Stream_Cart_ClipAnno Other Created by Greg Created from above
C:\HRC_TrailMap\Data\geodata\hr_county\Hydro\
geo |Stream Cart_Clip.lyr Streams_Cart_Clip.lyr Other Created by Greg Created from above
C:\HRC_TrailMap\Data\geodata\hr_county\Hydro\
geo |Stream Cart_ClipAnno.lyr Streams_Cart_ClipAnno.lyr Other Created by Greg Created from above
C:\HRC_TrailMap\Data\geodata\hr_county\Hydro\ Obtained directly from
geo |Waterbodies.gdb Waterbodies.gdb Geodatabase [Hood River County |agency
C:\HRC_TrailMap\Data\geodata\hr_county\Hydro\
geo |Waterbodies.gdb\Waterbody Waterbody Feature Class |Hood River County |" (Same as Above) "
geo |C:\HRC_TrailMap\Data\geodata\hr_county\Quarry Folder Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Quarry
geo |\Quarry.gdb Quarry.gdb Geodatabase [Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Quarry
geo |\Quarry.gdb\Rock Quarry Rock_Quarry Feature Class |Hood River County |" (Same as Above) "
geo |C\HRC_TrailMap\Data\geodata\hr_county\Taxlots Folder Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Taxlots
geo |\Parcel.gdb Parcel.gdb Geodatabase [Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Taxlots
geo |\Parcel.gdb\Taxlot 20130711 Taxlot_20130711 Feature Class |Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Timber
geo |Stands Folder Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Timber
geo |Stands\TimberStands.gdb TimberStands.gdb Geodatabase |Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Timber
geo |Stands\TimberStands.gdb\Sale_Units Sale_Units Feature Class |Hood River County |" (Same as Above) "
geo |C:\HRC_TrailMap\Data\geodata\hr_county\Trails Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Trails\T
geo |rails.gdb Trails.gdb Geodatabase [Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Trails\T
geo |rails.gdb\NW_Area_Trails NW_Area_Trails Feature Class |Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Trails\T
geo |rails.gdb\NW_Area_Trails_ORIGINAL NW_Area_Trails_ORIGINAL Feature Class |Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Transp
geo |ortation Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Transp
geo |ortation\Roads.gdb Roads.gdb Geodatabase [Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Transp
geo |ortation\Roads.gdb\Gates Gates Feature Class|Hood River County |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Transp
geo |ortation\Roads.gdb\HRC Forest_Roads HRC Forest_Roads Feature Class |Hood River County |[" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\hr_county\Transp
geo |ortation\Roads.gdb\Roads Roads Feature Class |Hood River County |" (Same as Above) "
geo
C:\HRC_TrailMap\Data\geodata\other_agency\crg Columbia River http://w w w .gorgecommis
geo |c\ NSA_Boundary.shp Shapefile Gorge Commission [sion.org/GIS-files.cfm
C:\HRC_TrailMap\Data\geodata\other_agency\crg Columbia River
geo |c\ NSA_Boundary AsLine.shp Shapefile Gorge Commission |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\crg Columbia River
geo |c\ Urban_Areas.shp Shapefile Gorge Commission [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\crg Columbia River
geo |c\ Urban_Areas_AsLine.shp Shapefile Gorge Commission [" (Same as Above) "
Obtained from Skamania
County but originally
dow nloaded froma
C:\HRC_TrailMap\Data\geodata\other_agency\od ODOT via Skamania |currently unknow n
geo |ot\hw ynet2007\ hw ynet2007.lyr Layer File County source w ebsite of ODOT.
C:\HRC_TrailMap\Data\geodata\other_agency\od ODOT via Skamania
geo |ot\hw ynet2007\ hw ynet2007.shp Shapefile County " (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\od ODOT via Skamania
geo |ot\hw ynet2007\ mileposts_2007.lyr Layer File County " (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\od ODOT via Skamania
geo |ot\hw ynet2007\ mileposts_2007.shp Shapefile County " (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\od ODOT via Skamania
geo |ot\ OR_Trans_Public_2012.gdb Geodatabase | County " (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\od ODOT via Skamania
geo |ot\ OR_Trans_Public_2012.gdb\OR_Trans_Public [Feature Class|County " (Same as Above) "
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Flag  "DataSources
GIS data website
By By By [data location or direct
Rick Greg Alyssa|type [File Location File Name (as stored in data directory) | Type of File[Agency name |source
http://spatialdata.oregone
C:\HRC_TrailMap\Data\geodata\other_agency\ore Oregon Geospatial |xplorer.info/geoportal/cat
geo |gon_geospatial_library\citylim 2007\ citylim_2007.lyr Layer File Data Clearinghouse |alog/main/home.page
C:\HRC_TrailMap\Data\geodata\other_agency\ore Oregon Geospatial
geo |gon_geospatial_library\citylim 2007\ citylim_2007.shp Shapefile Data Clearinghouse |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\ore Oregon Geospatial
geo |gon_geospatial_library\orcnty24\ orcnty24.shp Shapefile Data Clearinghouse |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\ore Oregon Geospatial
geo |gon_geospatial_library\ORStateParks\ OregonsStateParks.shp Shapefile Data Clearinghouse |" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\ska Obtained directly from
geo |mania_county\ColumbiaRiverShoreline\ ColumbiaRiverShoreline.gdb Geodatabase | Skamania County  |agency
C:\HRC_TrailMap\Data\geodata\other_agency\ska
mania_county\ColumbiaRiverShoreline\ColumbiaR Obtained directly from
geo |iverShoreline.gdb\ ColumbiaRiver_Shoreline_line Feature Class | Skamania County agency
C:\HRC_TrailMap\Data\geodata\other_agency\ska
mania_county\ColumbiaRiverShoreline\ColumbiaR Obtained directly from
geo |iverShoreline.gdb\ ColumbiaRiver_Shoreline_polygon Feature Class | Skamania County  |agency
Obtained from Skamania
County but originally
dow nloaded froma
C:\HRC_TrailMap\Data\geodata\other_agency\sta currently unknow n
te_or\hydro\orhydro_24k\geo_gis\hydro\Hydro State of Oregon via [source w ebsite of the
geo |2006\w ater_courses0907 ***MANY TABLES, Too many to list individually [ Table Skamania County  [State of Oregon.
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\hydro\orhydro_24k\ wb_oregon.shp Shapefile Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\hydro\orhydro_24k\ w c_oregon.shp Shapefile Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\hydro\ orrivers.pdf Other Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\hydro\ orrivers_epa250k_Clip.shp Shapefile Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\hydro\ orrivers_rr100k_Clip.shp Shapefile Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\hydro\ orrivers_usgs2000k_Clip.shp Shapefile Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\hydro\ PRJdevelopment.pdf Other Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\hydro\ rivers.pdf Other Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\plss\ plss_or.shp Shapefile Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\plss\ PRJdevelopment.pdf Other Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\sta State of Oregon via
geo |te_or\plss\ tow nship_range_or.shp Shapefile Skamania County  [" (Same as Above) "
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood_NF\NatlForestBoundary\ NatlForestBoundary Proclaimed.shp Shapefile USFS Mt Hood NF  |data-library/gis/mthood/
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood_NF\RecreationSites\ rec_site_pt.shp Shapefile USFS Mt Hood NF  |data-library/gis/mthood/
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood_NF\Transportation\ Transportation.gdb Geodatabase [USFS Mt Hood NF | data-library/gis/mthood/
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood_NF\Transportation\Transportation.gdb\ |RoadEvent Feature Class |USFS Mt Hood NF  [data-library/gis/mthood/
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood_NR\Transportation\Transportation.gdb\ | Trail Feature Class |USFS Mt Hood NF  [data-library/gis/mthood/
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood_NRF\Transportation\Transportation.gdb\ |TrailEvent Feature Class |USFS Mt Hood NF  [data-library/gis/mthood/
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood_NF\Transportation\Transportation.gdb\ | Transportation Feature Class |USFS Mt Hood NF  [data-library/gis/mthood/
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood_NF\Transportation\Transportation.gdb\ | TravelManagementArea Feature Class |USFS Mt Hood NF  [data-library/gis/mthood/
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood_NF\Transportation\Transportation.gdb\ | TravelRoute_In Feature Class |USFS Mt Hood NF  [data-library/gis/mthood/
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood NF\ Waterbody\w aterbody.shp Shapefile USFS Mt Hood NF | data-library/gis/mthood/
C:\HRC_TrailMap\Data\geodata\other_agency\usf http://www .fs.fed.us/r6/
geo |s\MtHood_NF\Wilderness_20110517\ Wilderness.shp Shapefile USFS Mt Hood NF  |data-library/gis/mthood/
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Appendix B - Developing a Water body vignette
Steps to create the Columbia River shoreline vignette using techniques in:

http://downloads.esri.com/support/whitepapers/ao /CoastalVignettes 031505.pdf
http://blogs.esri.com/esri/arcgis/2009/03/05/symbolizing-shorelines/
http://support.esri.com/en/knowledgebase/techarticles/detail/28823

Using the raster Euclidean distance tool method (Spatial Analyst>Distance>EuclideanDistance)

1. Create a polygon representing the land area of the shoreline.
a. Since I started with only a polygon layer of the water of the Columbia River, | made
a new polygon that loosely encompassed the entire boundary of the Columbia River
dataset. Then I used the Erase tool to remove the area of water from the polygon.
What remains is a polygon representing the shorelines and area of land around
borders of the Columbia River.
b. Make sure to deal with areas of islands appropriately.
2. Use the Euclidean distance tool to create a raster of this shoreline polygon dataset. Set the
output cell size to something appropriate (I used 10 ft). Leave everything else as default.
3. Once the Euclidean distance raster is created, use the Extract by Mask tool (Spat.
Analyst>Extraction>Extract by Mask) to extract only the area of the raster that is the
Columbia River. In other words, use the Columbia River polygon as the mask boundary.
The final raster is now what you want.
Symbolize it using light blue to darker blue (shallow to deep water).
In the symbology tab in the Histogram dialog you can drag the graph up and to the left (ie
add vertices). This makes the area of light color along the shoreline thinner.
7. Set transparency as desired.

o oA

50


http://downloads.esri.com/support/whitepapers/ao_/CoastalVignettes_031505.pdf
http://blogs.esri.com/esri/arcgis/2009/03/05/symbolizing-shorelines/
http://support.esri.com/en/knowledgebase/techarticles/detail/28823

Appendix C: Bump map techniques

Bump Map:

A methodology for creating a visual appearance of scattered vegetation for areas where Lidar
vegetation needs to be ‘removed’ to more accurately represent a clear cut or other timber
harvest while also having some randomly dispersed trees.

Note — You could create a fairly similar result without using Bump Mapping at all if all you
want is to remove areas of vegetation. You can just create a mask of the areas desired, then
use that mask to ‘clip’ just those areas from your copy of the Bare Earth dem (and/or
hillshade) and then use that to represent areas of clear cuts. The only difference is that these
areas will be entirely clear of all vegetation (bare earth) and may not look as realistic as if
Bump Mapping is completed.

If you want to make a representation that has some randomly dispersed trees (perhaps
looking more realistic), then proceed with the following directions.

*Note — Requires Spatial Analyst extension!

Read the following blog post about Bump Mapping:
http://blogs.esri.com/esri/arcgis/2010/01/21/introducing-the-arcgis-bump-map-tools/

As described in the blog, you can download the Bump Map tools (which includes the
Toolbox for ArcMap) from the following locatioin:
http://mappingcenter.esri.com/index.cfm?fa=arcgisResources.modelsScripts

Follow the directions in the blog and Resources page to add the ‘Bump Map Tools’ toolbar
to ArcToolbox in ArcMap

What you need:

A DEM (in our case we use the Lidar BE DEM for tool operation). We are also using a FF lidar
dem and hillshade as part of the intent of this work and for visualization.

A polygon layer representing stands that have been cut

Spatial Analyst Extension

1.

Create a polygon layer of treated timber stands in the project area:
a. Inour case we use the Sale_Units feature class and select only those stands that we
want.
i. These are stands harvested after the lidar flight date (based on available

metadata, the flight for Hood River/Gorge Area was flown between May 18
and July 26, 2008)

ii. Select all units (polygons) harvested (clear cut or other silvicultural
treatment) from 2008 to the present.

iii. Also make sure the selection is only the stand polygons in the project area.
Bump mapping requires a significant amount of processing. You want to
minimize the area to only the practical area.

iv. Export the selected stands to a new feature class.

b. As an added step, use the most current available aerial photo to cross-check the

accuracy of the ‘clear cut’ areas as represented by the polygon layer. Personal
knowledge or a site inspection may be required if new aerials are not available. Edit
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the polygons if necessary so they are an accurate representation of what has actually
been clear cut. Be particularly careful to make the polygons accurately reflect for
areas that are not actually cut (e.g. riparian buffers, etc.)

c. Separate polygons can also be created to represent different vegetation types if
desired.

= For example you could treat areas differently based on conifers (cones) or
hardwoods (domes) in the bump map tools.

= Perhaps some stands are clearcut and some are thinned and therefore you will
create different Bump Map settings for each (e.g. tree spacing, tree radius,
tree heights can be created differently for different areas, if desired).

d. If you are developing separate vegetation types then each different type should be its
own polygon feature class (e.g. a feature class of clearcut polygons, another feature
class of thinned stand polygons, a feature class of areas that will be hardwood areas
(domes) separate from a feature class that will have conifers(cones) etc.)

e. Split polygons if necessary to ensure each polygon really only represents one variety
of vegetation.

f. Create a new field in the attribute table of the feature class.

i. Call it something like: ‘RastValue’. Use short integer type.

ii. Use field calculator to add a unique value to each record in this field based on
unique vegetation variety.

1. Forexample: 1 = Clearcut, 2 = Thinned stand, 3 = unique riparian
area, etc.

2. Each different vegetation area can be constructed to have different
styles of vegetation (tree type [cone or dome], tree spacing, radius,
height)

2. Convert the ‘stands’ polygon layer to a raster

a. Use the Polygon To Raster tool (ConversionTools>To Raster> Polygon to Raster)

i. Inthe tool parameters, set the Value field to be the field in the polygon
dataset that you created and populated previously (e.g. ‘RastValue’) so that
the output raster will have cell values based on the values for each different
polygon of stand types.

ii. Set the cell size to be identical to the BE DEM dataset (use the browse dialog
to browse to that dataset)
iii. IMPORTANT: Set the environment settings

1. Setitto Snap To the BE DEM

2. Set the processing extent to ‘Same as’ the polygon input. Otherwise it
will use a larger processing area and it will take a long time.

iv. The output will be a raster representing cell values derived from individual
polygons.

v. For the sake of these directions, let’s say we named the output raster
“StandsAsRaster”

3. Use the Extract by Mask tool to extract the areas of the BE DEM that we need
a. Use Extract by Mask tool (Spatial Analyst Tools>Extraction>Extract by Mask)
i. Use the BE DEM as input

ii. Use the raster you previously created as the mask (i.e. “StandAsRaster”)

iii. Define the output name.

iv. IMPORTANT: Set the environment settings
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1. Setitto snap to BE DEM
2. Set the processing extent to ‘Same as” the previous raster (ie. the one
used as a mask which is “StandAsRaster”
b. The output will be the BE DEM for only the stands that we care about.
4. Use Extract by Attributes (Analyst Tools>Extraction>Extract by Attributes)
a. Use this to create individual rasters of stands for each of the different stand types.
I. The input raster in this example is “StandAsRaster”
ii. For the “Where clause’, enter a SQL statement such as "Value" =1, or
"Value" = 2, etc.
iii. Run the tool for each different stand type that you need for your individual
mask rasters (stands that will be bump mapped differently).
b. These will be used individually as mask rasters in the Bump Map Tool since a
separate mask raster is necessary for each different vegetation type to be created (i.e
bump mapped differently).

5. Start running the Bump Map tool.
a. Double click the Bump Map Model
= @ Bump Map Tools
5, Bump Map Script - Part 1
%7 Bump Map Scripk - Part 2
%7 Mo Bumps Script

b. This runs in batch mode so you can enter many lines (one for each different mask
area (ie. vegetation type))
[

B2EE)

Input Raster tion Mask) || Cones or Domes Vegetation Densi ity || Vegetation Radius. i i Input Raster (DEM) | Output Raster |
A H RickBumpMapTestingdownloadBu_|Cones

c. Based on the Bump Map documentation, the tool (python code) creates bumps with
an equation that uses the diameter of the bump divided by 11 when developing the
resolution of the cells used as part of the bump (to make smooth looking bumps). If
the diameter entered (it is actually entered as a radius so you must multiply be 2) in
the calculation divided by 11 creates a resolution smaller than the cell size of the
DEM then resampling to a higher resolution will occur for the entire DEM (this takes
longer). In other words, since our DEM has a resolution is 3 feet, if we enter a radius
of 16 (i.e. diameter of 32) we have 32/11 = 2.9090 so the tool will force resampling.
If we enter a radius of 17 (i.e. diameter of 34) we have 34/11 = 3.0909 so it is more
than the resolution of the DEM and therefore the tool will not do resampling and will
keep the output cell size at the initial size (i.e. 3).

d. Sizes for cones that I found to work well were:

I. For a clearcut but having a few scattered ‘leave trees’
1. Use ‘Cones’
2. Use Vegetation Density = 100 (i.e. one tree every 100 ft randomly
dispersed)
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3. Use Vegetation Radius = 17 (no resampling will occur)
4. Use Vegetation Height = 90
ii. For athinned area having many more scattered trees
1. Use the settings as above, except for change Vegetation Density

2.

| used a Vegetation Density of 25

iii. Use Domes if desired
1. Xx
2. XX

iv. XX

e. Output (a hillshade image) is added to the map and saved wherever you set for the
output location. In addition to the hillshade you can access the other intermediately
developed layers by going in to the Tool Data folder in the location where the tools

are installed.

= B3 BumpMapTools

+ [ Doc
E Scrfatch This i= 3 folder that I created and stored starting data
| Scripks and defined 23 an cutput location

= (3 ToolData

F 1 hre
I [+ m comyvegpat

""" conirer_ony These datszstz came with the download

+ B craterlakedem
+ [ sedqe only

+ veqpakl 3
+ ﬁ vegpakl ~J
= B vegplusdem

+ W@ BumpapTools.
|=] readme.txt

i. Itappears that a coordinate system is not assigned to these datasets by
default, however they are positioned appropriately so the user should be able
to assign the existing coordinate system to them.

ii. The name of the output items (shown in above image in orange) represent
some of the intermediate outputs that are generated in order to make the
finished hillshade. These are described as follows:

1.

2.

3.

4.

vegpatO (veg pattern 0) is the pattern of just the trees generated for the
first ‘stand’ type entered in the tool.

vegpatl (veg pattern 1) is the pattern of just the trees generated for the
second ‘stand’ type entered in the tool

comvegpat (complete veg pattern) is all of the vegetation patterns
combined.

vegplusdem (veg plus DEM) is everything combined and is used as
the input for the hillshade process.

iii. IMPORTANT: Note that the above described outputs ARE DELETED BY
THE SCRIPT EACH TIME YOU RUN IT so save a copy of them before re-
running the tool if you want to have them for later!
You can only create one vegetation type (style and specifics of the cone, dome, density, size,
etc.) for each stand type when you run the tool. However, you can do several iterations of
the same areas (e.g. one with cones and the next one with domes) and then combine the
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DEM rasters and take only the HIGHEST value from each raster. This will keep ALL
vegetation (cones and domes).

a. To do this use the Cell Statistics Tool (Spatial Analyst Tools>Local Toolset> Cell
Statistics)

b. Use the MAXIMUM parameter. This will determine the largest value of the inputs
on a cell-by-cell basis. This should accurately give the cell values for Bare Earth
locations as well as values for vegetation.

. Once you have a Hillshade and DEM that you are happy with, the next step is to merge it
into the original dataset(s) for final display in the map.

Use the Raster to Mosaic tool to mosiac the original Lidar FF DEM with the generated
Bump Map (FF) DEM. Make sure the Bump Map is set as the one that takes precedence for
areas of overlap. Once you generate a new DEM that includes both, then you can create a
hillshade for the final layer. You will also need to do a Raster Calculator operation to
subtract the finished the original BE DEM from the finished FF DEM (which is a
combination of the Lidar FF and the BumpMap FF DEMSs). This provides you with the final
raster that has only the values of the height of things that are above the ground (i.e.
vegetation). Use this as a transparent overlay to give color to the vegetation.
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EXAMPLES:

Cone shapes
(Conifers)

Dome shapes
(Hardwoods)

56



AFTER. Using Bump Mapping with two different spacing densities.
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Appendix D: Tint band techniques

How to Produce Tint Bands for Boundaries:

This methodology comes from:
http://blogs.esri.com/esri/arcqis/2007/04/17/how-to-produce-tint-bands-for-boundaries/

Steps:
1.

2.

8.

Identify the boundary layer (polygon) that you want to create a tint boundary for.

Convert the polygon to a raster using Conversion Tools>To Raster > Feature to Raster. You
will need a field in the polygon feature class that you set at the field value that each cell will
be set to in the new raster. For example, you can create a new field and use Field Calculator
to assign a ‘1’ to all records. Then each cell of the developed raster will have a value of ‘1°.
The number used, and therefore the value assigned to each cell, is irrelevant. You just have
to have something to assign to each cell.

Use the shrink tool on the raster. This is in Spatial Analyst Tools > Generalization >
Shrink.

In the shrink tool set the ‘Zone values’ to whatever is assigned to all cells (e.g. ‘1)

This outputs a new raster that has been shrunk around the edges by the amount (of cells)
specified.

Convert the full sized raster and the shrunken raster back into polygons (Conversion Tools>
From Raster > Raster to Polygon).

Use the erase tool to erase the shrunken polygon from the full sized polygon. What remains
will be the polygon representing the tint band.

Symbolize and set transparency as desired.

An example of tint bands (In this case used to differentiate ownership....County, State, Federal,
Private)
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Appendix E: Style Reference techniques
Add a new Style Reference to the Style Manager:

The default location on my machine where the styles are stored is here:
C:\Documents and Settings\rhollatz.SKACO\Application Data\ESRI\Desktop10.0\ArcMap
*(Yellow being your user profile)

55 |1 CDocuments and Settingstirhollatz, SKACOApplication Data\ESRINDeskiopl0.0ArcMap

3 x Marne Size  Type Date Modified

My Compuker A I Editer File Folder 12/2{2010 3:53 FM

H 344 Floppy (A1) L Templates File: Folder 121212010 2:53 PM

< Local Disk (1) thollatz style 8,236 KB STYLE File 719}2013 11:06 AM
+ ) ArcExplorer SkiHillsymbols2.style S40KE  STYLE File 72013 2136 P

# |03 arcgis TrailMapSymbals, style NS‘?D KB STYLE File F/11/2013 2:36 PM
) DESTutorial

You can copy the .style file to this location on your machine (or store it elseswhere)
Next, in ArcMap, open the ‘Customize’ menu and choose ‘Style Manager...’
As depicted in the drawing below:

Step 1:

Click the ‘Styles...” button.
Step 2:

Click the ‘Add Style to List...” button.
Step 3:

Navigate to the location where the .style file is and select it. Click ‘Open’. And ‘Ok’ on the
Style Reference Dialog.

You can now select the style in the Style Manager and look at its contents. This one has some
custom items in the ‘Marker Symbols’.

Now, back in ArcMap, if you open the Symbol Selector to edit any symbols you will have access to
these symbols.
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Style Manager

E]EI C:\Documents and S ettingsirhollatz
-5 ESRLstyle

MName

i | 1] ] l|

oo
1= =]

Style References

thallatz
130 Basic
120 Bilboards
130 Buildings
130 Industrial
12D Residential
12D Street Fumiture
13D Trees
12D Wehicles
[ eI S _Ewplarer

i

[

]2 UE| Ground Track Units

Add Style to List..

Set az Default List

Create Mew Style..

[

0K

J [

Cancel J

Open 2x)

Lack in: | I3 Archap v| Q2 e E-
r [CEditar
) Templates
My Recent rhollatz. style
Documents SkiHillSymbolsz. style
@ TrailMapSymbals. skyle
Diesktop
L% Step 3
by Documents
by Computer
by Mebwork File name: |TraiIMapSymbols.style b | [ Open ]
Places )
Files of type: |ESF|I Styles " style] v| [ Cancel ]I
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Style Manager

EIEI C:ADocuments and Settingzirho |

----- 7] Reference Systems
----- £ Maplex Labels

----- 7] Shadows

----- £ Area Patches

----- £ Line Patches

----- £ Marth Ao

----- 7] Scale Bars

----- £ Legend Items

----- 7 Scale Texts

----- £ Colar RBamps

----- 7] Borders

----- £ Backgrounds

----- £ Colars

7 Yectorization Settings
----- 59 Fill Symbals

----- £ Lirme Symbols
{5 Marker Symbals
----- F7 Text Symbols
7] Reprezentation Rules
] Hatches

|

Cloze

# Black Advanced
M Blue Intermediate
® Green Beqginner
# tarker Syrmbol

£ Representation Markers

View what 1z in there.

Select Marker Symbols




Appendix F: Draft Map*
*Provided here as a very low resolution image. A high resolution image of the full size 28”x 36”
image will be submitted with our report. Its file size is large (in excess of 120 MB).
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